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Standard & Poor’s Research InsightSM puts a wealth of financial data and insightful company
reports, performance graphs and textual documents at your fingertips—giving you the
perspective you need to determine a company’s true value and to identify buy/sell opportunities
well before your competition.

Research Insight also offers you the flexibility to link to Microsoft® Excel, and its powerful
graphical interface allows you to build, modify, generate and print multiple documents
simultaneously so that all of your work is immediately available.

With Research Insight you can easily

• target companies that meet your investment criteria

• perform credit analyses to evaluate credit risk, lending situations, cash 
management and industry trends

• evaluate a company’s vulnerability to merger or acquisition and develop contingency 
plans to deal with potential buyers for operations, divisions or businesses

• generate a competitive analysis to compare profitability, financial risk and growth 
among companies, industry sectors and indexes

• evaluate the performance of strategic business units based on contribution to 
the corporate performance, relative strength and industry attractiveness

This chapter

• highlights the available COMPUSTAT® databases

• shows you how to select your default database

• shows you how to choose or change your default research styles

• describes additional resources for working with the COMPUSTAT databases

1
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Built on the Solid Foundation of COMPUSTAT® Data
Knowing your financial analyses will only be as strong as the data they are based on, we built
Research Insight on the unparalleled foundation of Standard & Poor’s COMPUSTAT data.

Since 1962 COMPUSTAT has been setting the industry standard for worldwide financial data
collection. Extensively trained financial researchers extract financial information from
companies’ annual and quarterly shareholder’s reports, Securities and Exchange Commission
(SEC) 10-K and 10-Q reports, daily news services and direct company contact. We constantly
monitor the rulings of the Financial Accounting Standards Board and the SEC to ensure that we
collect and present financial data as consistently as possible.

Since presentations of financial data and reporting methods vary among companies and
industries, COMPUSTAT uses standardized data definitions and collection procedures to assure
a consistent presentation of data. Computerized validation and balancing models are designed to
guarantee the most comparable and consistently accurate data available. This consistency gives
you accurate comparisons of information across companies and over time.

For example, comparing sales figures published in annual reports is often misleading because
some companies report sales figures which include excise taxes while others exclude them. In the
COMPUSTAT (North America) and COMPUSTAT (Global) databases, the standard definition
of sales always excludes excise taxes. As a result, sales figures are not distorted by different
reporting methods.

COMPUSTAT Databases
We are committed to providing you with the most comprehensive and current databases of
fundamental financial and market information available today. When using Research Insight, you
will access either the COMPUSTAT (North America) database or the COMPUSTAT (Global)
database, depending on your subscription. Each database is described below.

COMPUSTAT (North America)
The (North America) database contains up to 20 years of annual data, up to 48 quarters of
history, seven years of business and geographic segment, and 240 months of stock prices and
dividend data. Fundamental financial and market data for over 11,100 U.S. and Canadian
companies provides a broad base for analysis of the North American market. The database also
contains data for over 10,900 inactive companies that no longer file with the Securities and
Exchange Commission due to a merger, liquidation or bankruptcy, etc. 

COMPUSTAT (Global)
Our international database features detailed information on companies, indexes and currencies
from around the globe. With more than 15,300 industrial and financial services companies
representing over 80 countries, market data including over 90 local market indexes, and over
110 currencies, the Global database represents over 80% of the world’s market capitalization. 

Standard & Poor’s Research Insight - Getting Started
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COMPUSTAT (Classic)
COMPUSTAT (Classic) is an as-reported historical database that provides non-restated,
quarterly COMPUSTAT data as it was originally collected by Standard & Poor’s. This database
allows you to look at data, as it was originally reported, at any point in time.

COMPUSTAT (BackData)
COMPUSTAT (BackData) provides historical annual and quarterly restated COMPUSTAT
(North America) data for testing models and validating theories. Annual data is available from
1950 forward; quarterly data from 1962 forward.

Daily Prices
The Daily Prices database enables you to retrieve the previous day’s stock price and other market
data. Daily Prices data is integrated with Research Insight so your financial analyses and
investment decision-making can be accomplished in a single application. Daily Prices is available
with a separate subscription.

Insider Trading
Insider Trading Data in Research Insight is provided by Washington Services Association
(WSA). The Insider Trading data features Top Ten Buys and Top Ten Sells, Summary data,
Open market transactions of 100 or more shares, 13 months of History, Issue-level data, Data in
Actual Numbers, Amended data, and adjustment for stock splits. Insider Trading Data is
available through the Internet download of the Value- Added database using the Research
Insight Task Scheduler.

Institutional Ownership
Institutional Ownership Data in Research Insight is provided by Computershare Analytics,
N.A., Inc., which collects and adds value to a vast amount of proprietary financial data and
distributes that data through subscriptions and partnerships with Internet financial networks
and leading data providers. The Institutional data features Top Ten Buys, Top Ten Sells, Top Ten
Changes, Top Ten Holders, Aggregate data, 4 quarters of data stored as monthly items, and
Issue-level data. Institutional Ownership share-related items have been adjusted for stock splits
and dividends. Institutional Ownership data can be accessed through an Internet download of
the Value- Added database using the Research Insight Task Scheduler.

Thomson I/B/E/S
The Institutional Brokers Estimate System (I/B/E/S), provided by Thomson Financial, is a
database of earnings expectations data obtained from more than 2,500 security analysts. The
consensus earnings estimates for more than 3,000 companies are available with a separate
subscription agreement.
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THOMSON FIRST CALL
The FIRST CALL database, provided by FIRST CALL/Thomson Financial, contains daily
consensus earnings & cash flow estimates, analysts' recommendations and related investment
information from hundreds of contributing firms. This database is available with a separate
subscription agreement.

Estimates are provided for two quarters and two fiscal years of consensus estimate data, expected
report dates, consensus recommendations, future growth rates, surprise data, operating actual
earnings and cash flow data, and P/E, as well as Price to Cash Flow ratios. The FIRST CALL
database also contains estimate consensus trends and estimate revision momentum data to help
you compare recent performance to expected performance. 

If you are a FIRST CALL subscriber, you can download daily FIRST CALL data from the
Internet through the Task Scheduler.

Stern Stewart’s EVAntage TM

Stern Stewart’s  EVAntage is a comprehensive financial analysis of 1,300 publicly traded, U.S. -
based, non-financial companies, encompassing both performance and valuation. Stern Stewart’s
EVAntage is available with a separate subscription.

Textual Databases
The Library is another integral component of Research Insight that enables you to retrieve
information from the different COMPUSTAT textual databases. Each database is 
described below.

Business Descriptions
The Business Descriptions database contains descriptions for over 12,000 companies. The
database information is compiled by Standard and Poor’s analysts and is updated continually. 

Trends and Projections
Trends & Projections is a monthly publication written by David M. Blitzer, Managing Director
and Chief Investment Strategist of Standard & Poor’s. This document, provided by DRI•WEFA,
covers current economic issues.

Country Overviews
The Country Overviews database from DRI•WEFA contains economic information and
forecasts for over 65 countries.
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Selecting the Default Database
Research Insight gives you access to the Standard and Poor’s database(s) to which you have
subscribed. If you subscribe to a single database (e.g. COMPUSTAT (North America)), your
default database is selected automatically. If you subscribe to multiple databases, here are the
steps you should follow when you want to switch the default database.

Begin from the Research Insight desktop.

1. From the Databases menu, select Default Database.

2. Select COMPUSTAT.
3. Click OK.

The COMPUSTAT (North America) database is now your default database. Any applications
you run during this session will use data from this database.

Choosing Default Styles
Research Insight can be customized to suit your particular research needs. During initial
installation of Research Insight, you may choose from five different styles: Money Management,
Credit, Corporate Finance, Transfer Pricing or EVAntage (requires a separate subscription). Each
style places a different group of financial and market indicators and data items in the Research
Assistant, which is used to screen the COMPUSTAT (North America) database. You can also
change the default style at any time, as well as add or change specific indicators and items on the
Research Assistant.

The Money Management setting defaults to the indicator groups (i.e. Valuation, Fundamentals,
Market, etc.) and indicator items (i.e. Issue Market Value, Sales, Price-Monthly, etc.) most
commonly used by Money Managers. 

The Credit setting defaults to the indicator groups (i.e. Fundamentals, Debt Coverage Ratios,
Activity Ratios, etc.) and indicator items (i.e. Revenues-Total, LTD to Total Cap, Total Asset
Turnover, etc.) most commonly used by Credit Managers. 

The Corporate Finance setting defaults to the indicator groups (i.e. Company Specifics,
EBITDA, Growth, etc.) and indicator items (i.e. Economic Sector Code, EBIT Margin, Sales
5Yr CAGR, etc.) most commonly used by Corporate Finance clients.
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The Transfer Pricing setting defaults to the indicator groups (i.e. Fundamentals, Relative Ratios,
N-Tiles, Fractiles Ratios, etc.) and indicator items (i.e. Revenue-Total, Relative Gross Profit
Margin, Inter-Decile Sales, etc.) most commonly used by Transfer Pricing clients.

Likewise, the EVAntage setting defaults to the indicator groups (i.e. EVA, Ranks, Capital
Intensity, etc.) and indicator items (NOPAT, EVA Margin, Widening Spread) most commonly
used by EVAntage customers.

To change your default setting after you have installed Research Insight, begin by closing the
Welcome to Research Insight window. From the Tools menu, select Options.

You will see the Options dialog box. Click the Styles tab, highlight the default option you
prefer and click Set Active Style. You can also change a style name, create a copy of a style,
create a new style, delete a style or restore the styles to the default settings.
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Where to Go When You Have Questions
This training guide is a hands-on learning tool. It is designed to take you through some of the
many uses and applications of Research Insight. Since it’s impossible to show you all of the ways
that you can use Research Insight, we’ve selected some commonly used applications that you can
immediately apply to your own work. 

You will also find on-line help in Research Insight to be a valuable resource for step-by-step
instructions for software functionality, detailed data definitions, reference tables, frequently
asked questions and more. To access on-line help, select Help from the Research Insight menu
bar.

On-Screen Help
On-screen help is available in windows where the button appears.

Window Tips offer a brief explanation on the functions of menu commands, toolbar buttons,
parts of dialog boxes and the windows in the Research Insight Assistants. Display Window
Tips by clicking the        button on the Research Insight desktop or the       button in a dialog
box. When the cursor changes to a question mark, simply click an item for more information. 

Tool Tips give you a description of tool buttons in the toolbar when you position the mouse
pointer over the tool.

Web site
Visit Standard & Poor’s web site at http://www.compustat.com for information on
Standard & Poor’s products. 

Customer Support
Assistance is also available from the Standard & Poor’s Customer Support Department. 

U.S. and Canadian clients can call toll free 800.523.4534 between 8:00 a.m. and 8:00 p.m.
ET, Monday through Friday.

Clients in Mexico can call 01.800.288.2872, and after the prompt, dial 800.523.4534.
International clients can call 44.20.7826.8580 between 9:00 a.m. and 5:30 p.m. GMT.

Please visit the Customer Support web site at http://support.compustat.com.
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This chapter describes the various windows, toolbars and buttons you will see in Standard &
Poor’s Research Insight. It shows you how to navigate through Research Insight by describing
the elements of the

• Welcome to Research Insight window

• Research Insight desktop

• Research Assistant

• Report Assistant

• Chart Assistant

• Run Assistant

• Look Up List

Chapter 2
Navigating Research Insight
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Welcome to Research Insight Window

The Welcome to Research Insight window is your entry to the basic functions of Standard &
Poor’s Research Insight. When you click a button or corresponding text with your mouse, you
will be taken to one of the many different functions of Research Insight. If you do not want this
window to automatically display when you enter Research Insight, click the Display on
Startup check box to turn off the default setting. Below is a description of each icon on the
Welcome to Research Insight window.

Research Assistant: define your screening criteria, then develop custom 
reports and charts, or access pre-defined reports or charts.

Report Assistant: develop custom reports, then define your screening criteria.

Chart Assistant: develop custom charts, then define your screening criteria.

Company Highlights: run a financial highlights report for one or more companies.

Library: retrieve Business Descriptions and Trends and Projections.

Open Screen: open pre-defined screens or develop a new screen.

Open Report: open pre-defined reports or build a new report.

Open Chart: open pre-defined charts or build a new chart.

Open Set: open pre-defined sets or develop a new set.

Prices, News and Headlines: access Real Time for current prices and news.

Closes the Welcome window and displays the Research Insight desktop.
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Research Insight Desktop

The desktop provides another way to access all the features of Research Insight. It displays when
you close the Welcome window, or whenever you click Cancel in the Research Assistant. To
return to the Welcome window click the         (Welcome) button or select Welcome to
Research Insight from the Help menu. The buttons on the toolbar at the top of this
window are described below. 

Create a new report, chart, screen or set

Open an existing report, chart, screen or set

Print

Copy

Cut

Welcome Window

Run a report, chart, screen or set

About Research Insight

Context sensitive help

Look Up

Paste

Save

Report Assistant:
develop custom
reports, then define
your screening criteria

Research Assistant: define your screening criteria, then
develop custom reports and charts, or access pre-defined
reports or charts.

Open Set: open pre-
defined sets, or 
develop a new set.

Open Chart: open
pre-defined charts, or
build a new chart.

Opens Real Time for current prices and news.

Open Screen: open pre-defined screens, or develop a new
screen.

Chart Assistant: 
develop custom
charts, then define
your screening
criteria.

Company Highlights: run a financial highlights report for
one or more companies.

Open Report: open pre-defined reports, or build a new
report.

Launch Market Insight

Launch Company Home Page

Launch Library
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The Research Assistant
The Research Assistant is a wizard designed to walk you through screening the database. The
Research Assistant can also link to other wizards in Research Insight to build reports or charts
with the results of your database screen. For more information on how to screen the database
with the Research Assistant, see Chapter 3 - Screening with the Research Assistant. 

Following is a description of each version of the three Research Assistant windows.

Research Assistant - Step 1 Window

This window lets you search for companies using specific screening criteria. You can conduct a
broad search for companies that are in the same industry sector, economic sector, SIC, NAICS
or GICS Code or country. 

Using the Change Set feature, you can narrow your search criteria by selecting a specific set of
companies as your starting point (e.g. S&P 500).  Screening criteria can be narrowed further by
using the tabs on the right side of the window, checking the necessary fields under each tab and
selecting the ranges from the drop down lists. 

Enter
company
tickers here

Change the
initial set of
companies here

Narrow your
screening criteria
here

Select one
to compare
similar
companies



Chapter 2 - Navigating Research Insight

13

Following is a description of each button displayed in this window.

Opens the Look Up List where you can search for a company by
name or ticker symbol.

Opens the Initial Set dialog box where you can choose a set of 
companies as the starting point for your screen.

Opens the File Open window, which allows you to open predefined or
previously saved screens.

Erases information you have entered in the window.

Opens the Research Assistant - Step 1 Classic View window, for
access to more advanced screening options.

Restores the default settings of the window.

Saves your screening criteria for use in future analysis.

Saves your screening criteria with a specific name in a specific 
location.

Opens the Custom Indicators window, which allows you to customize 
Indicator Groups (e.g. Valuation, Market, etc.) and Indicator Items
(e.g. Beta, Sales, etc.).

Opens the Research Assistant - Step 2 window.

Closes the Research Assistant.

Displays step-by-step Help topics.
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Research Assistant - Step 1 - Classic View Window

This window allows you to view and modify the underlying Base Set and Formulas used in
developing your screen. To modify information, click on the field, enter the new information on
the command line and press Enter on your keyboard. This window is accessed by clicking the
Classic View button on the Research Assistant - Step 1 window. If you make modifications in
this window, you cannot return to the Research Assistant - Step 1 window. Following is a
description of each button displayed in this window.

Opens the File Open dialog box, where you can open predefined or
previously saved screens. 

Returns you to the Research Assistant - Step 1 window (only if you 
have not modified any information).

Erases the information you have entered in the window.

Restores the default settings of the window.

Calculates the results of your screen.

Calculates your results for a specific time period.

Prints the formulas used in developing your screen.

Saves your screening criteria for use in future analysis.

Saves your screening criteria with a specific name in a 
specific location.

Opens the Research Assistant - Step 2 window.

Enter your
base set
information
here

Enter your
formulas
here
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Research Assistant - Step 2 Window

This window displays your screening results based on the criteria established in the first Research
Assistant window. In this window, you can add companies to your set or remove any companies you
do not want included in your set. You can also display the set by company name or ticker symbol.
Following is a description of each button displayed in this window.

Opens the Look Up List where you can search for a company by
name or ticker symbol.

Adds the ticker in the Add Company to set field to your set.

Saves your set or your screen.

Allows you to save your set or your screen in a specific location with
a specific name.

Restores your set to the last version saved.

Removes the highlighted company from the Company List and from
the Added Companies list.

Removes the highlighted company from the Company List.

Inserts the highlighted company back into the Company List.

Launches Market Insight, which gives you on-line access to
up-to-date financial information through reports such as Country
Overviews, Risk Reports, Company Profiles, Balance Sheet 
Statements, Income Statements, and Financial Analysis Reports.

Note: Market Insight requires a separate subscription from 
Research Insight.

Returns you to the previous window (Research Assistant - Step 1).

Opens the Research Assistant - Step 3 window. 

Add
companies
to your set
here

Companies
added to
your set are
displayed
here

Companies
removed from
your set are
displayed
here

The set of
companies
that passed
your screen
appear
here
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Research Assistant - Step 3 Window

This window links the Research Assistant to additional Research Insight functions. The Report
Assistant and Chart Assistant options take you to wizards that allow you to build
customized reports or charts. The Open Report and Open Chart options allow you to run a
pre-defined report or chart or build new ones. The Company Highlights option runs a
company highlights report. Selecting Finish returns you to the Research Insight desktop. 

Following is a description of each button displayed in this window.

Returns you to the previous window (Research Assistant - Step 2).

Opens the next window based on the selection made.

Select another
Research Insight
function here
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The Report Assistant
The Report Assistant is a wizard designed to walk you through building and running custom
reports. Depending upon which type of custom report you choose to work with, the Report
Assistant can consist of up to three windows. The Report Assistant can be used as an extension
of the Research Assistant to build a custom report with the results of your database screen or 
by itself with the aid of the Run Assistant as the method you use to screen the database. For
more information on how to work with a custom report using the Report Assistant, see 
Chapter 4 - Reports.

Following is a description of the three Report Assistant windows.

This window is used to define specific report parameters when building your own report. It
opens when you choose the Report Assistant option on the Research Assistant - Step 3
window, or when you click the Report Assistant button on the Research Insight desktop.
You can create a report using the current time period, or you can choose to compare data
items and companies over a specified period of time with an historical analysis report. If
you are building a report for the current time period and you select Companies vs.
Items, you can choose to display multiple companies in your report by entering the
number of companies in the Company Count field. 

Following is a description of each button displayed in this window.

Returns you to the previous window.

Opens the Report Assistant - Step 2 window. 

Select a
format for
reports run in
the current
time period

Click here
to begin
creating a
free-form
report

Select a
format for
reports run
for a specific
period of time

Shows how your
report will be
formatted

If you selected
Companies vs.
Items under
Current Time
Period, enter the
number of
companies to
include in your
report here

Report Assistant - Step 1 Window
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Report Assistant - Step 2 Window

This window is used to select the broad item groups and specific data items within a
group/category that you want to appear in your report. Following is a description of each button
displayed in this window.

Adds new items chosen from the Look Up List to the Selected Items area.

Opens the Look Up List where you can search for a specific item to add
to your report.

Opens the Customize Item Sets dialog box where you can modify or
create new item sets and items.

Adds the items selected from the Items area to the Selected Items area.

Adds all the items in the Items area to the Selected Items area, which 
lists all items that will appear on your report.

Removes any highlighted item(s) from the Selected Items area.

Opens the Item Set Definition dialog box, where you can modify the 
highlighted Selected Item.

Opens the Item Definition dialog box where you can view the definition
of the highlighted Item

Returns you to the Report Assistant - Step 1 window.

If you are running an historical analysis report, this button opens the 
Report Assistant - Step 3 window.

If you are running a current time period report, this button opens your 
completed report.

Adds the items you used to screen the database to your report.

Moves the selected item up or down one position in the list; this affects
where the item will appear in the report. 

Select the
broad Item
Groups and
specific
data Items
to include in
your report

Displays the
selected
item’s
mnemonic

You can add
other items or
functions to your
report here

The items you
have added will
appear here

Displays the
selected item’s
mnemonic
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Report Assistant - Step 3 Window

This window displays after you choose to build a report based on an historical analysis and
select the item categories and specific items within a category that you want to appear on your
report. This window lets you enter the Beginning and Ending Periods you want to use when
you run historical analysis reports. 

This window also gives you the option of selecting a Relative, Absolute or Calendar time period
for your report. 

The Relative time period requires a point of reference in order to determine which time period
is being referenced (e.g. the last three years, the most recent four quarters, etc.). Relative enables
you to rerun your report in subsequent periods without changing the reference. The default
Beginning and Ending periods are 0 where 0 represents the most current time period (e.g.
annual, quarterly, monthly, etc.) for which data is available. One period prior to the current
period is indicated by [-1], two periods prior to the current period is indicated by [-2], etc.

The Absolute time period tells the exact time period and ensures that a specific time period’s
data is returned (e.g. May01 for May 2001 or Y01 for fiscal year 2001).

The Calendar time period is an exact calendar year, quarter, month, week or day. The calendar
time period is always the exact year in which the time period ends. For example, suppose a
company's fiscal year-end is May 2001. The calendar time period for annual data is 2001. 

If you have selected data items with different periodicities (e.g. annual sales, quarterly EPS), this
window will also prompt you to select an alignment for the data. 

Following is a description of each button displayed in this window.

Returns you to the previous window (Report Assistant -Step 2).

Displays the Run Assistant window or your completed report,
depending upon from where you accessed the Report Assistant.

Chapter 2 - Navigating Research Insight

Enter the
Beginning and
Ending Time
Periods for
your report

Choose a
Relative,
Absolute or
Calendar
format

Select the
alignment to
apply to all the
items here 
(e.g. Annual,
Quarterly,
Monthly, etc.)
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Report Window

This window displays a report according to the companies and criteria you established in the
Research and Report Assistants. Under the File menu, you can choose to Close or Save your
report, create a New report or Open an existing report. If you close or save your file, you will
be taken out of the Research Assistant.

Click the        (Run) button to access the Run Assistant window where you can modify your
screening criteria for a report. To rerun the report with different data items, click the
(Rerun Assistant) button or select Rerun Report/Chart Assistant from the Report menu.
To return to the Research Assistant click the        (Research Assistant) button on the
desktop.

Click here
to display
the report,
or its
underlying
formulas
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The Chart Assistant
The Chart Assistant is a wizard designed to walk you through building and running custom
charts. Depending upon which type of custom chart you choose to work with, the Chart
Assistant can consist of up to three windows. The Chart Assistant can be used as an extension
of the Research Assistant to build a custom chart with the results of your database screen or
by itself with the aid of the Run Assistant as the method you use to screen the database. For
more information on how to work with a custom report using the Report Assistant, see 
Chapter 5 - Charts.

Following is a description of the three Chart Assistant windows.

Chart Assistant - Step 1 Window

This window is used to define specific chart parameters when building your own chart. It
displays when you choose the Chart Assistant option on the Research Assistant - Step 3 window
or when you click the Chart Assistant button on the Research Insight desktop. You can select
the chart style along with how many companies are to appear on the chart. In addition, you can
create a chart using the current time period, or you can choose to specify the period of time for
an historical analysis chart. Following is a description of each button displayed in this window.

Returns you to the previous window.

Opens the Chart Assistant - Step 2 window. 

Select a
chart style
here

Select one
or multiple
companies
to display
in your
chart

Displays what your
chart will look like

Select a time
period here

Select a time
reference here
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Chart Assistant - Step 2 Window

This window is used to select the broad item groups and specific data items within a
group/category that you want to appear on your chart. Following is a description of each button
displayed in this window.

Adds new items chosen from the Look Up List to the Selected 
Items area. 

Opens the Look Up List where you can search for a specific 
item to add to your chart.

Opens the Customize Item Sets dialog box where you can modify or 
create new item sets and items.

Adds the items selected from the Items list to the Selected Items area.

Adds all the items displayed in the Items list to the Selected Items 
area, which shows all items that will appear on your chart.

Removes any highlighted item(s) from the Selected Items area.

Opens the Item Set Definition dialog box, where you can modify the
highlighted Selected Item.

Opens the Item Definition dialog box where you can view the 
definition of the highlighted item.

Returns you to the Chart Assistant - Step 1 window.

If you are running an historical analysis report, use this button to open
the Chart Assistant - Step 3 window.

If you are running a current time period report, this button opens your
completed chart.

Adds the items you used to screen the database to your chart.

Moves the selected item up or down one position in the list; this 
affects where the item will appear in the chart.

The items you
have selected for
your chart
appear here

The mnemonic
for each selected
item appears
here

You can select
additional items
not displayed on
the screen using
the Look Up List

Activate these
general item
groups and
then select
specific data
items to
include in your
chart
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Chart Assistant - Step 3 Window

This window displays after you choose to build a chart based on an historical analysis and select
the item categories and specific items within a category that you want to appear on your chart.
This window lets you enter the Beginning and Ending Periods you want to evaluate when
you run historical analysis charts.

This window also gives you the option of selecting a Relative, Absolute or Calendar time period
for your chart. 

The Relative time period requires a point of reference in order to determine which time period
is being referenced (e.g. the last three years, the most recent four quarters, etc.). This option
enables you to rerun your report in subsequent periods without changing the reference. The
default Beginning and Ending periods are 0 where 0 represents the most current time period
(e.g. annual, quarterly, monthly, etc.) for which data is available. One period prior to the current
period is indicated by [-1], two periods prior to the current period is indicated by [-2], etc.

The Absolute time period ensures that a specific time period’s data is returned (e.g. May01 for
May 2001 or Y01 for fiscal year 2001).  

The Calendar time period is an exact calendar year, quarter, month, week, or day. The calendar
time period is always the exact year in which the time period ends. For example, suppose a
company's fiscal year-end is May 2001.  The calendar time period for annual data is 2001. 

If you have selected data items with different periodicities (e.g. annual sales, quarterly EPS), this
window will also prompt you to select an alignment for the data. 

Following is a description of each button displayed in this window.

Returns you to the previous window (Chart Assistant - Step 2).

Displays the Run Assistant window or your completed chart, depending 
upon from where you accessed the Chart Assistant.

Enter the
Beginning and
Ending Time
Periods for your
chart

Choose a
Relative, Absolute
or Calendar
format

Select the
alignment to apply
to all the items
here
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Chart Window

This window displays a chart according to the companies and criteria you established in the
Research and Chart Assistants. Under the File menu, you can choose to Close or Save your
chart, create a New chart or Open an existing chart. If you close or save your file, you will be
taken out of the Research Assistant. Click the       (Run) button to access the Run Assistant
window where you can modify your screening criteria for a chart. To rerun the chart with
different data items, click the       (Rerun Assistant) button or select Rerun Report/Chart
Assistant from the Report menu.

To return to the Research Assistant click the        (Research Assistant) button on the
desktop. 

Below is a description of each chart toolbar button.

Copies chart to the clipboard as a bitmap

Copies data to the clipboard as text

Modify chart style

Rotates chart

Zoom

Z-clustered series

Show or hide legend

Vertical grid

Edit titles

Change fonts

Change colors and patterns

Displays chart properties dialog box

Horizontal grid

Show or hide series legend

Switches between 2-D and 3-D views

Select
viewing
options here

Click here to
view multiple
companies
by Ticker or
Name

When running a chart
for multiple companies
click on a ticker or
name to display the
chart for that company

Modify chart
attributes
here
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File Open Window

This window displays when you choose the Open Report or Open Chart option on the
Research Assistant - Step 3 window or when you click the Open Report or Open Chart
button on the Research Insight desktop. From this window you can open pre-defined reports
or charts. Following is a description of each button displayed in this window.

Allows you to open files residing in other drives.

Opens the Report Assistant - Step 1 window where you can create your
own report.

Opens the Chart Assistant - Step 1 window where you can create your own
chart.

Returns you to the previous window.

Runs and displays the highlighted report or chart.

Click on the
folders to
display all
predefined
reports and
charts
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The Run Assistant
The Run Assistant window automatically opens before a custom report or chart is generated
when you do not pre-screen the database with the Research Assistant. The Run Assistant
window also displays after you have selected a pre-defined report or chart from the File Open
window or when you click         (Run) to re-run a report or chart. 

The Run Assistant does not guide you from one window to another. Instead, it has four stacked
tabs in one window, each of which you must click to access. With the Run Assistant, you can
create or modify the screening criteria, choose or change the set, modify the time period or view
and change the underlying Base Set and Formulas for a report or chart.

Run Assistant - Screen

The Run Assistant - Screen tab allows you to create or modify the database screening criteria for
the report or chart you want to run or re-run without using the Research Assistant. This tab
contains the same buttons as the Research Assistant - Step 1 window except for the Next
button. Instead, it contains the OK button, which runs the report or chart according to the
screening criteria you just defined in the Run Assistant window. See page 13 for a description of
the remaining buttons.
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Run Assistant - Set

The Run Assistant - Set tab allows you to choose or change the set of companies for the report
or chart you want to run or re-run. This tab contains the same buttons as the Research Assistant
- Step 2 window except for the Next and Back buttons. Instead, it contains the OK button,
which runs the report or chart according to the set you just chose in the Run Assistant window.
See page 15 for a description of the remaining buttons.
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Run Assistant - Report Time Periods

The Run Assistant - Report Time Periods tab allows you to modify the time period for the
report or chart you want to run or re-run. This tab functions like the Step 3 windows of the
Report and Chart Assistants. It gives you the option of selecting a Relative, Absolute or
Calendar time period for your report or chart. 

The Relative time period requires a point of reference in order to determine exactly what time
period is being referenced (e.g. the last three years, the most recent four quarters, etc.). This
option enables you to rerun your report in subsequent periods without changing the reference.
One period prior to the current period is indicated by [-1], two periods prior to the current
period is indicated by [-2], etc.

The Absolute time period ensures that a specific time period’s data is returned (e.g. May01 for
May 2001 or Y01 for fiscal year 2001).

The Calendar time period is an exact calendar year, quarter, month, week or day. The calendar
time period is always the exact year in which the time period ends. For example, suppose a
company's fiscal year-end is May 2001.  The calendar time period for annual data is 2001. 
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Run Assistant - Screen - Classic View

The Run Assistant - Screen - Classic View tab allows you to view and change the underlying
Base Set and Formulas for the report or chart you want to run or re-run. This tab contains the
same buttons as the Research Assistant - Step 1 - Classic View window except for the Next and
Back buttons. Instead, it contains the OK button, which runs the report or chart according to
the Base Set and Formulas you just viewed or defined in the Run Assistant window. See page 14
for a description of the remaining buttons.
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The Look Up List
The Look Up List is a Research Insight tool that enables you to look up information about the
companies, items, functions and sets included in the database. Like the Run Assistant window,
the Look Up List is comprised of four stacked tabs. It displays when you select Look Up from
the Tools menu or whenever you click the        (Look Up) button. 

The Look Up button is found throughout Research Insight, and if you access the Look Up List
with the button, the contents of the list changes according to where the button is located. For
example,

• if you click the Look Up button in the upper right-hand corner of the 
Research Assistant - Step 2 window, the Look Up List displays with only the
Look Up - Companies tab

• if you click the Look Up button on the Initial Set dialog box, the Look Up List 
displays with only the Look Up - Set tab

• if you click the Look Up button in the upper right-hand corner of the 
Report Assistant - Step 2 window, the Look Up List displays with the 
Look Up - Items and the Look Up - Functions tabs

• if you access the Look Up List from the Tools menu with the Look Up button
on the Research Insight Desktop or from the Research Assistant Classic View, 
it displays with all four tabs.

Buttons
All four tabs in the Look Up List contain most of the same buttons. Following is a description
of the buttons common to all tabs in the Look Up List.

Pastes the company, set, item or function into the field from which you
accessed the Look Up List.

Copies the company, set, item or function to your computer’s clipboard
so you can paste it wherever you want.

Closes the Look Up List.

Displays Help for the window you are in.
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Look Up - Companies

To open the Look Up List from the Tools menu, select Look Up...

The Look Up - Companies tab lists every company and index in the COMPUSTAT (North
America) database by tickers and names, and by the set to which they belong. With the Look
Up - Companies tab, you can search for a company using the partial or whole name, and you
can look up the industry segment information for a company as well. This tab allows you to sort
the companies within a set by either ticker symbols or names.

The Look Up - Companies tab contains all the buttons common to the Look Up List (see page
30). In addition, it contains the Segments button, which accesses the Segments dialog box so
you can view the industry segment information for a company.
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Look Up - Items

To open the Look Up List from the Tools menu, select Look Up...

The Look Up - Items tab lists every data item and concept within the database by category, by
name and by mnemonic. With the Look Up - Items tab, you can search within a category for an
item using the partial or whole name, and you can look up the data definition for the item as
well. This tab allows you to sort the items within a category by either mnemonics or names.

The Look Up - Items tab contains all the buttons common to the Look Up List (see page 30).
In addition, it contains the Definition button, which accesses the COMPUSTAT (North
America) Data Definitions window so you can view the definition of the item.
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Look Up - Functions

To open the Look Up List from the Tools menu, select Look Up...

The Look Up - Functions tab allows you to look up the different categories of functions (pre-
defined calculations) within the database. With the Look Up - Functions tab, you can search
within a category for a function using the partial or whole name, as well as review the definition
for the function.

The Look Up - Functions tab contains all the buttons common to the Look Up List (see page
29). In addition, it contains the Definition button, which accesses the COMPUSTAT (North
America) Data Definitions window so you can view the definition of the function.
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Look Up - Sets

To open the Look Up List from the Tools menu, select Look Up...

The Look Up - Sets tab lists the sets available in the database. With the Look Up - Sets tab, you
can search within a category for a set using the partial or whole name, and you can look up any
sets you have stored outside the database on your computer or network.

The Look Up - Sets tab contains all the buttons common to the Look Up List (see page 29). In
addition, it contains the Browse button, which accesses the Open dialog box so you can view
any sets you have stored outside the database and add them to the database, if necessary.



Are you looking for companies with a consistent record of outperforming their peers? Which
semi-conductor companies have the lowest price-to-earnings ratios? What companies made up
the S&P 500 in 1984? No matter what your questions are, the Research Assistant feature in
Standard & Poor’s Research Insight can guide you to the answers. 

Research Insight gives you a powerful, yet easy-to-use tool for screening (searching) the extensive
COMPUSTAT (North America) and COMPUSTAT (Global) databases for companies,
industries and economic sectors that meet an endless range of criteria. You can run pre-defined
screens built into the software (e.g. low price-to-book or quality blue chip stocks) or quickly
create your own screens using the Research Assistant. Your screening criteria can include
individual data items, concepts or formulas. The companies that pass your screen can be saved
in a set so you can use the data in future analyses.

This chapter shows you how to

• define screening criteria

• customize screening criteria

• save the results of a screen

• access the Classic View of a screen

Note: The procedures in this chapter use the Money Management default style. To change your
style to Money Management, select Options from the Tools menu, select the Style
tab, select the Money Management style and click Set Active Style.
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Chapter 3
Screening COMPUSTAT
(North America) with the

Research Assistant



Defining Screening Criteria and Viewing 
the Results of a Screen

The first step in running a screen is to define your screening criteria. Let’s say, for example, that
you want to identify all the active companies with the same SIC classification as 3Com
Corporation whose Return on Assets were greater than 12%.

Begin from the Research Insight Desktop.

1. Click the       (Research Assistant) button.
2. Enter the ticker symbol for 3Com Corporation (coms) in the Companies field.

Hint: To search for a ticker symbol, click the Look Up button. Begin typing in the name of
the company in the Select Companies field. When the name is highlighted, click Paste,
then click Close. The company’s ticker symbol will appear in the Companies field.

3. Select SIC from the Find Similar Companies area.

4. Select the Fundamentals tab and click the ROA (Return on Assets) check box.
5. Ensure > is selected from the drop-down list to the right and enter 12.0 in the far

right field. 
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6. Click Next. Research Insight will screen the North America database and the results will
appear on the Research Assistant - Step 2 window.

Let’s take a closer look at these companies by viewing their 5 Year Annual Balance Sheet reports.

7. Click Next to open the Research Assistant - Step 3 window.
8. Click the Open Report radio button and click Next to open the File Open window.
9. Select the Annual Balance Sheet - 5 Years report and click Finish.

You’ll see the report for the first company in your set.

Hint: Click the Name button to display the list of companies by company name. 
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To view the same
report for other
companies in this
set, click the Next
or Prev button. Or
you can press F7 to 
move ahead or F8
to move backward
through the list of
companies.



Changing Your Initial Set and 
Defining Multiple Criteria and Ranges

When you screen the COMPUSTAT (North America) database, Research Insight searches
against a subset of the total population to find the companies that meet your criteria. This
subset is called the initial set. Research Insight pre-defined sets contain groups of companies,
issues or business segments. Sets are identified by the dollar sign ($) followed by an abbreviation.
Examples of sets in COMPUSTAT (North America) include $C—the active U.S. companies
and $SP_500—all companies in the S&P 500. A complete list of available sets can be found in
the Look Up list under the Sets tab. The default set is $C (the Active U.S. companies). You can
change the initial set to any pre-defined set or create your own set by saving your screen results.

Now let’s say you want to search for companies in the S&P 500 with a price/earnings ratio
between 25 and 30 and a year-to-date return of more than 15%.

Begin from the Research Assistant - Step 1 window.

1. Click Change Set to display the Initial Set dialog box.
2. Enter $SP_500 in the Set field and click OK.

Hint: If you don’t know the name of a specific set, click the Look Up button, select a set, click
Paste, then click Close. The set name will be inserted in the Set field.

3. Select the Valuation tab and click the Price to Earnings check box.
4. Select Range from the drop-down list to the right. 

The Edit Range Values dialog box appears.
5. Enter 25.00 in the Start of Range field, 30.00 in the End of Range field, and click

OK.

6. Select the Returns tab and click the YTD Return check box.
7. Select > (greater than) from the drop-down list to the right and enter 15 in the far right field.
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8. Click Next. 
Research Insight will screen the North America database, and the results will appear on 
the Research Assistant - Step 2 window.

Assuming you are satisfied with the results, we will now save the screen. 

Hint: Saving the screen allows you to run the screen in the future using your defined criteria 
and formulating an up-to-date set. Or, you can save the original companies in the set by 
clicking the Save button in the Save Set area.

To save your screen

1. Click Save As in the Save Screen area.

2. Select a location to save your screen. We will save ours in Research Insight/Csscns (the 
default location).

3. Enter a screen name in the File Name field and click Save.
The screen is now saved for use in future analyses.
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Customizing Screening Criteria
Research Insight offers the ultimate in flexibility by allowing you to customize your default
screening criteria. The following example shows how you can customize the Research Assistant
to meet your specific needs.

Note: Customizing your criteria will cancel your existing screening selections.

Let’s say you want to screen the COMPUSTAT (North America) database for active companies
with GICS Codes 35102010 through 35102030.

Begin from the Research Assistant - Step 1 window.

1. Click Customize to display the Custom Indicator Groups dialog box.
2. Under Indicator Groups, highlight the Company Specifics group.
3. Under Indicator Items, check the GICS Sub-Industry check box.

4. Click OK, and select whether or not you want to make the customization 
changes permanent.

5. Select the Company Specifics tab and click the Industry Sector Code check box.
6. Select Range from the drop-down list to the right.
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7. Select 35102010-Health Care Distrib & Services from the Start of Range
drop-down list, 35102030-Managed Health Care from the End of Range
drop-down list and click OK.

8. Click Next. Research Insight will screen the North America database and the results will 
appear on the Research Assistant - Step 2 window. From this window you can add or 
remove ticker symbols, save your set, save your screen or continue to the next window
and use your set in a report or chart.
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Accessing the Classic View of a Screen
To access the Classic View window, click the Classic View button on the Research Assistant -
Step 1 window. The Classic View window allows you to view and modify the underlying Base
Set and Formulas used in developing screens in the Research Assistant. However, if you make
modifications in this window you cannot return to the first Research Assistant window. 

You can also work in the Classic View window to develop and run your own customized screens
by inserting various formulas.

The following example uses the Research Assistant - Step 1 - Classic View window to find all
active companies that have a Market Value greater than $1 billion and a monthly P/E less than 18.

Begin from the Research Assistant - Step 1 window.

1. Click Classic View.
2. Select the Base Set cell in the first row, enter $C in the command line and press Enter.

3. Select the Set cell in the same row, enter line1 in the command line and press Enter.
4. Select the Base Set cell in the second row, enter $line1 in the command line and press

Enter.
5. Select the Formula cell in the same row, enter mkvalm>1000 in the command line 

and press Enter.
6. Select the Set cell in the same row, enter line2 in the command line and press Enter.
7. Select the Base Set cell in the third row, enter $Line2 in the command line and press

Enter.
8. Select the Formula cell in the same row, enter pem<18 in the command line and press

Enter.
9. Click Run. Research Insight will screen the North America database and display the

number of companies that passed the criteria in the Passed column.
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10. Click Next to view the set of companies in the Research Assistant - Step 2 window. From
this window you can add or remove tickers, save your set, save your screen or continue to 
the next window and use your set in a report or chart.
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Exercises
You can practice using the Research Assistant by recreating the following scenarios.

I. Identify companies that have had 5 consecutive years
of sales increases.

Begin from the Research Assistant - Step 1 window.

1. Select the Growth tab and click the No.Yrs. Sales Increase check box.

Note: If the tab or check box is not available, refer to page 81 - Customizing Screening Criteria.

2. Select = from the drop-down list to the right, and enter 5 in the far right field. 

3. Click Next. Research Insight will screen the North America database and the results will 
appear on the Research Assistant - Step 2 window. From this window you can add or 
remove ticker symbols, save your set, save your screen or continue to the next window and 
use your set in a report or chart.
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II. Identify companies in the S&P Super Composite whose
price/earnings ratio is greater than its industry average.

Begin from the Research Assistant - Step 1 window.

1. Click Change Set to display the Initial Set dialog box.
2. Enter $SP_Super in the Set field and click OK.

Hint: If you don’t know the name of a specific set, click the Look Up button, select a set, click
Paste, then click Close. The set name will be inserted in the Set field.

3. Click Customize to display the Custom Indicator Groups box.
4. Under Indicator Groups, highlight the Relative (Industry) group.
5. Under Indicator Items, select the Relative PE check box.

6. Click OK and select whether or not you want to make the customization changes permanent.
7. Select the Relative (Industry) tab and click the Relative PE check box.
8. Select > from the drop-down list to the right.

9. Click Next. The results of your inquiry will appear on the Research Assistant - Step 2 
window.



III. Screen the North America database to identify mid-cap
companies* with a price-to-book ratio of less than 1.5% and an
earnings per share of more than 10% over the past three years.

* Criteria defining mid-cap companies vary widely. In this example, we will define mid-cap
companies as those that have a monthly market value between $39 million and $2.786 billion.

Begin from the Research Assistant - Step 1 window.

1. Click Customize to display the Custom Indicators dialog box.
2. Highlight Growth from the Indicator Groups and select the EPS 3yr CAGR check box 

under the Indicator Items.

Hint: Only 6  items can be activated at one time for each group. Simply click the check box
next to an item to remove the check mark in it. 

3. Click OK and select whether or not you want to make the Customization changes 
permanent.

4. Select the Growth tab, click the EPS 3yr CAGR check box, select > from the 
drop-down list to the right and enter 10 in the far right field.

5. Select the Valuation tab, click the Market Value check box and select Range 
from the drop-down list to the right. The Edit Range Values dialog box appears.

6. Enter 39 in the Start of Range field, 2786 in the End of Range field and click OK.
7. Click the Price to Book check box, select < from the drop-down list to the right, 

enter1.5 in the far right field and click Next. 
Research Insight will screen the North America database, and the results will appear on 
the Research Assistant - Step 2 window. 
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IV. Identify value or growth stocks.

First, follow the instructions in Chapter 11 - Importing and Downloading, to download the
Value-Added Data including the Value/Growth Indicator. 

Next, to identify Growth/Value stocks, begin from the Research Assistant - Step 1 window.

1. Click Customize.
2. Under Indicator Groups, click New to display the Create Indicator Group dialog box.
3. Enter Custom in the Group Name field and click OK.

4. Under Indicator Items, click New to display the Indicator Item Definition dialog box.
5. Click the        (Look Up) button to display the Look Up List.
6. Enter Value/Growth in the Select Items field. The Value/Growth - Indicator

item will automatically be highlighted.

7. Click Paste, then click Close. The mnemonic VALGROW will automatically be 
inserted into the Expression field.

8. Click Accept Expression.

Chapter 3 - Screening COMPUSTAT (North America) with the Research Assistant

47



9. Click OK. You will see the new item Value/Growth in the Indicator Items area of the 
Custom Indicator Groups dialog box.

10. Click OK again and select whether or not you want to make the Customization
changes permanent.

11. Select the Custom tab and click the Value/Growth Check box. If you want to view
Value companies, select 0-Value from the far right drop-down list. 

12. Click Next to display the results.

From this window you can add or remove tickers, save your set, save your screen or 
continue to the next window and use your set in a report or chart.
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Standard & Poor’s Research Insight is your best resource to quickly access detailed financial
information on thousands of companies around the world. You will find dozens of pre-defined
reports in Research Insight, including the most commonly used income statement and balance
sheet reports or design and build your own using our unique Report Assistant wizard. With the
Research Assistant, you can also create a free-form report selecting the data you want to display
and customizing the layout to your own specifications. 

This chapter shows you how to

• run a Company Highlights report

• run a pre-defined report for one or more companies

• modify a pre-defined report 

• create a table report using the Report Assistant

• create a free-form report using the Report Assistant

Note: The procedures in this chapter use the Money Management default style. To change
your style to Money Management, select Options from the Tools menu, select the
Style tab, select the Money Management style and click Set Active Style.
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Running a Company Highlights Report
First, we’ll show you how easy it is view financial highlights for a company. Here’s how you run
a Company Highlights report for Wm. Wrigley Jr. Company.

Begin from the Research Insight desktop.

1. Click the        (Company Highlights) button. The Run Assistant window will appear 
on top of the Company Highlights report window. The Run Assistant is similar to the
Research Assistant window.

2. Enter the ticker symbol for Wrigley (wwy) in the Companies field and click OK.
A Company Highlights report will appear.

Hint: Click the        (Run) button to open the Run Assistant window where you can change
your initial set, or modify your base set and criteria. To view a Business Description or
Trends and Projections report for the company, click the        (View Text) button.
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Running a Pre-defined Report
With just a few clicks of the mouse, you can open and run a pre-defined report and choose the
company or set of companies that you want to appear in the report. For example, to view a 
5 Year Annual Balance Sheet on Exxon Mobil Corporation, follow the steps below.

Begin from the Research Insight desktop.

1. Click the        (Open Report) button.
You will see the File Open dialog box

2. From the Balance Sheets folder select Annual Balance Sheet-5 Years and 
click Finish.
You will see the Run Assistant window.

3. Enter the ticker symbol xom (Exxon Mobil) in the Companies field.

Hint: To find a company’s ticker symbol, click the        (Look Up) button.
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4. Click OK. The 5 Year Annual Balance Sheet for Exxon Mobil will appear on your screen

Hint: To modify, add or view the underlying formulas for this report, select the Formula
radio button in the Show area. To open another report, click the        (Open Report)
button from the desktop. To change your initial set or modify your base set and criteria,
click the         (Run) button to open the Run Assistant window. To view a Business
Description or Trends and Projections report for the company, click the        (View Text)
button.

Running a Pre-defined Report on Multiple Companies
Now let’s say you wanted to look at a 5 Year Annual Balance Sheet on several of Exxon Mobil
Corporation’s peers: Chevron Corporation and Texaco Incorporated. You would follow steps 1
and 2 on the previous page.

1. Enter the ticker symbols of the peer companies in the Companies field, separating 
each ticker symbol with a comma (i.e. chv, tx).

2. Click OK. A 5 Year Annual Balance Sheet report will appear for the first company. 

Hint: To view the report for the other companies, click the ticker symbol of the company 
in the Companies area. Click the Name button to display the list of companies by 
name.  To view a Business Description or Trends & Projections report for the company,
click the         (View Text) button.
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Modifying a Pre-defined Report
To demonstrate how easy it is to modify a pre-defined report, here is how you could change the
title of the 5 Year Annual Balance Sheet report you ran in the previous example.

Begin with the report displayed on your screen.

1. Click the Formula radio button in the Show box.
The underlying formulas for the report are displayed.

2. Click the Annual Balance Sheet text box.
3. Place your cursor in the upper command line, change ANNUAL BALANCE SHEET

to PEER BALANCE SHEET and press Enter.
The new title will appear in the text box.

4. Click the       (Run) button.
The Run Assistant window displays with the tickers CHV and TX in the Companies field.

5. Click OK.
The new title will appear in the report on your screen.
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Creating a Table Report
Although Research Insight offers a comprehensive library of pre-formatted reports, there will be
many instances when you want to create your own table report. In a table report, data is
displayed in rows and columns, and titles are automatically provided for each column. Table
reports are useful when you need to display information for a large number of companies at the
same time. 

Let’s say you want to prepare a table report that compares data for Arnold Palmer Golf Co.,
Black Rock Golf Co., Callaway Golf Co., and S2 Golf Inc.

Begin from the Research Insight desktop.

1. Click the        (Report Assistant) button.
2. Click the Items vs. Companies radio button under Current Time Period.

3. Click Next.
4. Click the Valuation radio button and select the Return on Equity item.
5. Click Add.
6. Click the Income - Annual radio button and select the Sales item.
7. Click Add.
8. Click the EPS & Shares radio button and select the EPS Basic Exc Extra item.
9. Click Add.

Hint: If the radio buttons you need are not displayed, click Customize and select the items
you need from the Item Group category and Item List box. Click OK, and choose
whether or not to save your changes.
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10. Click Finish.
11. In the Run Assistant window, enter your target companies’ ticker symbols, separating each

ticker symbol with a comma. (3apgc,3blrk,ely,golf).

12. Click OK. Your table report will appear on the screen. 

Hint: Once you have run the report, you may need to expand some of the columns in order
to see the whole column title. To access the underlying template for your table report,
click the Formula radio button in the Show area of the window. Click on one of the
column title cells to activate it, and place the cursor in the bottom right hand corner
of the cell. The cursor will change to a crossbar tool. Hold the left mouse button down
and drag the corner of the cell to the right to expand it so that the entire title is visible.
Click the        (Run) button and click OK in the Run Assistant window to re-run the
report with your modifications. To rerun the report with different data items, click the

(Rerun Assistant) button or select Rerun Report/Chart Assistant from the 
Report menu.
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Sorting Columns in a Table Report
Sorting determines the order in which companies are displayed in your table. Research Insight
automatically displays the companies alphabetically by name. If you prefer, you can sort the
companies by values in any column in either ascending or descending order. We’ll use the table
report created in the previous example and sort the report by company name in descending order.

Begin from the table report.

1. Click the Formula radio button in the Show box to display the underlying template for 
the report.

2. Select the Company Name cell and right-click the mouse. 
3. Select Sort Order from the drop-down list.

You will see the Table Sort Order Selection dialog box.

4. Company Name is already highlighted in the Columns in Sort list box, so simply click 
the Descending radio button and then click Close.

5. Click the        (Run) button.
The Run Assistant window displays with the tickers 3apgc,3blrk,ely and golf in the 
Companies field. Click OK.
The report now displays by company name in descending order.
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Creating an Historical Analysis Table Report
In addition to viewing current reports, Research Insight lets you build and view reports using
historical data. Now we will view data for the same companies from our previous example for
the last 3 years.

Begin from the Research Insight desktop.

1. Click Report Assistant.
2. Under Historical Analysis, click the Items vs. Companies radio button and click Next.
3. Repeat steps 4–9 from the example on pages 54–55 - Creating a Table Report.
4. Click Next.
5. When the Report Assistant - Step 3 dialog box appears, click the Relative radio button.
6. Enter 0Y in the Beginning Period field (to signify the current year), and enter -2Y in 

the Ending Period field (to signify 2 prior years). Notice that the Alignment area shows
that the data will be aligned to annual. 

7. Click Finish.
8. In the Run Assistant window, enter your ticker symbols, separating each symbol with a 

comma. (3apgc,3blrk,ely,golf).
9. Click OK. Your table report will appear on the screen. 
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Selecting Time Periods
When you select a Current Time Period report on the Report Assistant - Step 1 window, it will
return a report with the most current data available—whether the data you have requested is
annual, quarterly, monthly, etc. 

If you choose an Historical Analysis report in the Report Assistant - Step 1 window, you will be
prompted to select a time period on the Run Assistant - Step 3 window. You can enter the
beginning and ending time periods for the report in the Periods section of the window

Relative retrieves data for a specific time period relative to the current time period. An
example of a relative time period would be the current year (0Y) vs. the past two years
(-1Y and -2Y). Absolute retrieves data for a specific date. An example of an absolute time
reference would be to use a beginning period of August 2000 and an ending period of
December 2000. Calendar retrieves data for the same approximate time frame for companies
with different fiscal years.

Creating a Free-Form Report
In addition to table reports, Research Insight lets you create your own free-form reports, which
can be helpful for displaying information about companies, industries or sectors in a format
customized to your specific needs. 

For instance, here is how you could use a free-form report to evaluate the relative performance
of Coca-Cola Company and Pepsico Inc.

Begin from the Report Assistant.

1 Click the Blank Report radio button and click Finish.
2. From the Toolbar, click the        (Add Text) tool. You will see the letter T attached to your

cursor.
3. Position your cursor at the top center of the blank report and click once.

You will see a new text cell that you will use as a label for your report title.
4. Click the text cell, enter Quick Prices and press Enter. Now that you have named the

report, you will insert more text cells. Notice that you can place your text cells anywhere on
the desktop.
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5. Click the        (Add Text) tool again and position your cursor below and to the left of 
your report title. Click once to create the first text cell. Position the cursor below the cell 
and create another text cell. Repeat until you have a vertical column of four text cells. 

6. Enter Company Name in the first text cell and press Enter.
7. Enter the following into the next three text cells: Total Return/S&P 500,

PE/S&P 500 and Price/S&P 500 - Monthly. 

8. Click the       (Add Formula) tool. You will see an @ symbol attached to your cursor. 
9. Position your cursor to the right of your text cells and click once to create the first 

formula cell. Position the cursor below the cell to create another formula cell. Continue 
until you have a vertical column of four formula cells next to your text cells. 

10. Click on the first formula cell, enter conm (Company Name) and press Enter. The item
conm will display the full names of your target companies. 
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11. Enter the following into the next three formula cells: trt5y500, pe500 and pr500m. 
12. Click the       (Run) button.

You will see the Run Assistant window.
13. Enter your target companies’ ticker symbols in the Companies field (ko,pep),

separating each symbol with a comma.
14. Click OK.

Hint: To view the report for the other company, click the Next button, or click the ticker
symbol or company name in the Companies area. To view a Business Description 
or Trends and Projections report for the company, click the        (View Text) button.
To change your initial set or modify your base set and screening criteria, click the

(Run) button to open the Run Assistant window.



Exercises
You can learn more about the Report functions in Research Insight by recreating the following
scenarios using the Research and Report Assistants. 

I. Create a table report showing current Sales and P/E Monthly
for all the companies in the S&P 100.

Begin from the Research Assistant - Step 1 window.

1. Click Change Set to display the Initial Set dialog box.
2. Enter $SP_100 in the Set field and click OK.
3. Click Next. You will see the names of the companies included in the S&P 100.

4. Click Next again.
5. Click the Report Assistant radio button and click Next.
6. Click the Items vs. Companies radio button under Current Time Period and click Next.
7. Click the Valuation radio button, select Price/Earnings - Monthly and click Add.
8. Click the Income - Ann radio button, select the Sales item and click Add.
9. Click Finish. Your report will appear on the screen.
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II. Create a table report showing current Sales and P/E Monthly
for all the companies in the S&P 500 for the past three years,
and modify the report to display subtotals by SIC Code.

Begin from the Research Assistant - Step 1 window:

1. Click Change Set to display the Initial Set dialog box.
2. Enter $SP_500 in the Set field and click OK.
3. Click Next. You will see the names of the companies in the S&P 500 on your screen.
4. Click Next again.
5. Click the Report Assistant radio button and click Next.
6. Click the Items vs. Companies radio button under Historical Analysis and click Next.
7. Click the Valuation radio button, select the Price/Earnings - Monthly item and

click Add.
8. Click the Income - Ann radio button, select the Sales item and click Add.
9. Click Next.

You will see the Report Assistant - Step 3 window.
10. Enter 0Y in the Beginning Period field (to signify the current year), and -3Y in 

the Ending Period field (to signify 3 prior years). Notice that the Alignment area 
shows that the data will be aligned to annual. 

11. Click Finish. Your report will appear on the screen.
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12. Click the Formula radio button. You will see the underlying formula for your report. 
13. Right-click the Earnings-Month text cell and select Insert Column from the 

drop-down menu.

14. Click the blank formula cell below the Column text cell, enter SIC and press Enter.
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15. Double-click the SIC formula cell.
You will see the Column Attributes dialog box.

16. Click the Display Subtotals check box. Note that the Suppress Repeating Values
box is automatically checked.

17. Click OK.
18. Click the        (Run) button to re-run your report with your changes.
19. In the Report Assistant window, click OK. Your new report will appear on the screen.
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III. Create a report comparing sales, research and development
expenditures and total return to shareholders of competitors Ford
Motor Co., Honda Motor Ltd. and General Motors Corp. over a
five-year period.

Begin from the Report Assistant

1. Click Blank Report. 

2. Click Finish.
You will see a blank report on your screen.

3. From the Report Toolbar, click the        (Add Text) tool.
4. Position your cursor at the top center of the blank report and click once.

You will see a new text cell that you will use as a label for your report title.
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5. Click the       (Select) tool, click on the text cell, enter 5-Year Performance and 
press Enter. 

6. Click the       (Add Text) tool again, and position your cursor below and to the left of 
your report title. Click once to create the first text cell. Position your cursor below the cell 
and create another text cell. Repeat until you have a vertical column of four text cells. 

7. Enter Company Name in the first text cell and press Enter. 
8. Enter the following into the next three text cells: Sales, R&D, and 5 Year Return.

9. Now, click the        (Add Formula) tool. You will see an @ symbol attached to 
your cursor. 

10. Position your cursor to the right of your text cells and click once to create the first 
formula cell. Move the cursor down to create another formula cell. Continue until you have
a vertical column of four formula cells.
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11. Click on the first formula cell, enter conm, and press Enter. The item conm will
display the full names of your target companies. 

12. Enter the following into the next three formula cells: @pavg(sale,-5,0), 
@pavg(xrd,-5,0) and trt5y.

13. Click the       (Run) button.
14. In the first Research Assistant window, enter your target companies’ ticker symbols 

(f,hmc,gm) separating each symbol with a comma. Click OK. 

Hint: To move between reports for the other companies, click the ticker symbol or company
name in the Companies area.
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Charts not only make your information easier to read and understand, but they can also help
you identify trends, make comparisons and clarify relationships that may not otherwise be
apparent.

Standard & Poor’s Research Insight provides you with an extensive collection of pre-defined
charts to help you bring your financial analysis to life. This collection includes the most
commonly used charts for both the COMPUSTAT (North America) and COMPUSTAT
(Global) databases. We’ve made it easy for you to modify these charts by changing the chart
style, colors and axis labels. You can also add titles, change fonts and customize the legend. 

Research Insight also gives you the flexibility to create your own charts. With just a few clicks of
the mouse, you can select the data you want to display and design a chart to your own unique
specifications.  

This chapter shows you how to

• use pre-defined charts

• modify pre-defined charts 

• create your own charts

Note: The procedures in this chapter use the Money Management default style. To change your
style to Money Management, select Options from the Tools menu, select the Style tab,
select the Money Management style and click Set Active Style.
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Using Pre-defined Charts
Research Insight gives you the flexibility to evaluate your target companies using a variety 
of pre-defined charts.  Here is how to run a 5 Year Total Return to Shareholders chart for
Merck & Co.

Begin from the Research Insight desktop.

1. Click the        (Open Chart) button.
You will see the File Open dialog box.

2. Open the Market folder, and select 5 Year Total Return to Shareholders.
3. Click Finish.

You will see the Run Assistant window.

4. Enter the ticker symbol mrk (Merck & Co.) in the Companies field and click OK.
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A 5 Year Total Return to Shareholders chart appears for the company.

Hint: To view the underlying formulas for the corresponding report, select the Formula radio
button in the Show area. To view the corresponding report for this chart, click the Report
radio button. You can also view the report and chart at the same time by clicking the
Report & Chart radio button. To open another chart, click the        (Open Chart)
icon on the desktop. To change your initial set or modify your base set and criteria, click
the        (Run) button.
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Running a Pre-defined Chart for Multiple Companies
Now let’s say you want to look at a 5 Year Total Return to Shareholders chart on companies in
the S&P 500 with the same SIC Code as Merck & Co. Follow the steps in the previous
example, except in the Run Assistant window

1. Enter mrk in the Companies field.
2. Highlight SIC in the Find Similar Companies list.
3. Click Change Set to display the Initial Set dialog box.

4. Enter $SP_500 in the Set field and click OK.

Hint: If you don’t know the name of a specific set, click the Look Up button, select a set, click
Paste, then click Close. The set name will be inserted in the Set field.

5. Click OK again. A 5 Year Total Return to Shareholders chart appears for the first company.

Hint: To view this chart for the other companies, click the ticker symbol of the company
located in the Companies area. Click the Name button to display the list of companies
by company name. To save the chart, select Save As from the File menu.  Enter a
name in the File Name field and click Save.  To print the chart, select Print from 
the File menu.
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Modifying a Pre-defined Chart
When a pre-defined chart is displayed on your screen, you can use the Chart toolbar at the top
of the screen to modify how the chart is displayed. You can use the previous example for
running a pre-defined chart on multiple companies.

1. Click the           (Change Gallery Type) button from the Chart toolbar and select
Columns to display the chart in a column format.

2. Click the       (Switch between 3D and 2D Views) button to view the chart in 3D.

3. Click the       (Horizontal Grid) button to remove the grid.
Your chart should now look like this:
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Creating Your Own Charts
With Research Insight you can quickly create your own custom charts using the Chart Assistant.
All you have to do is select the type of chart and the companies you want to appear in your
chart, and Research Insight will retrieve and display the information you requested. The
following example shows you how to create a bar chart comparing credit worthiness information
for Ames Dept Stores, Target Corp., K Mart Corp. and Wal-Mart Stores.

Begin from the Research Insight desktop.

1. Click the       (Chart Assistant) button.
2. Click the Bar radio button in the Chart Style area.
3. Click the Multiple Companies radio button in the Companies per Chart area.
4. Click the Current Period radio button in the Periods area, and click Next.

5. Click the Credit Worthiness radio button from the Item Groups area.
Hint: If the radio buttons you need are not displayed, click Customize and select the items

you need from the Item Group category. Click OK, and choose whether or not to save 
your changes.
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6. Click the Add All button in the middle of the window to move all the Credit Worthiness 
items over to the Selected Items area, and click Finish.

7. In the Run Assistant window, enter the companies’ ticker symbols (ames,tgt,km,wmt)
separating each with a comma.

8. Click OK. Your custom chart will appear on the screen.

Hint: To view the underlying formulas for the corresponding report, select the Formula radio
button in the Show area. To view the corresponding report for this chart, click the Report
radio button. To view the report and chart at the same time, click the Report & Chart
radio button. To change your initial set or modify your base set and screening criteria,
click the        (Run) button to open the Run Assistant window. To select different items
to appear in the chart, click the        (Rerun Assistant) button or select Rerun
Report/Chart Assistant from the report menu.
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Because you have your own unique style for evaluating the markets, individual companies and
industry sectors, we’ve made it easy for you to customize Standard & Poor’s Research Insight.
With just a few clicks of the mouse, you can customize Research Insight to place the data items
and concepts you use most frequently on your desktop. 

This chapter shows you how to

• establish default style settings

• customize the Research Assistant window

• add data items and concepts 

• import/export styles

Chapter 6
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Choosing or Changing Styles
During your initial installation of Research Insight, the styles you may choose from include
Money Management, Credit, Corporate Finance, Transfer Pricing and EVAntage (available with
a separate subscription). However, you can change your default setting anytime you are working
in the software. Each style changes the Research Assistant - Step 1 to show specialized groups of
data items commonly used in screening for companies that meet the needs of a particular
research style.

The Money Management setting defaults to the indicator groups (i.e. Valuation, Returns,
Growth, etc.) and indicator items (i.e. Market Value, Beta, YTD Returns, etc.) most commonly
used by Money Managers. 

The Credit setting defaults to the indicator groups (i.e. Fundamentals, Ratings,  etc.) and
indicator items (i.e. Sales, Senior Debt Rating, etc.) most commonly used by Credit Managers. 

The Corporate Finance setting defaults to the indicator groups (i.e. Company Specifics,
EBITDA, etc.) and indicator items (i.e. Economic Sector Code, EBIT Margin, etc.) most
commonly used by Corporate Finance clients.

The Transfer Pricing setting defaults to the indicator groups (i.e. Relative Ratios, Transfer
Screen, etc.) and indicator items (i.e. Relative Market Value, Mark Up, etc.) most commonly
used by Transfer Pricing clients.

Likewise, if you subscribe to Stern Stewart’s EVAntage, the EVAntage setting defaults to the
indicator groups (i.e. EVA, Ranks, Capital Intensity, etc.) and indicator items (NOPAT, EVA
Margin, Widening Spread) most commonly used by EVAntage clients.



To change your default setting after you have installed Research Insight, begin by closing the
Welcome to Research Insight window. From the Tools menu, select Options. You will see the
Options dialog box.

Click the Styles tab, highlight the default styles option you prefer and click Set Active
Style. This dialog box also allows you to: change a style name, create a copy of a style, create
a new style, delete a style, restore default styles, import a style or export a style.

Customizing Indicators and Item Sets
You can further customize your screening options by selecting different indicator groups and
data items that display on the Research Assistant - Step 1 window.

From the Tools menu, select Options. Select the Styles tab, and click the Indicator Groups
button.
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In the Custom Indicator Groups dialog box, the check marked indicator groups and items are
displayed in the Research Assistant and are used to define your screening criteria. Highlight an
indicator group to see which items appear within the group. If you do not want a specific group
or item to display in the Research Assistant, simply deselect the check box next to the
appropriate group or item. An item is activated only when a check mark appears. Only 6 items
can be activated at one time for each group. Unchecked groups and items can be added to the
Research Assistant at any time by clicking the appropriate check box.

To create a new indicator group
1. Click New in the indicator group area.
2. Enter a name in the Indicator Group Name field of the Create Indicator Group

dialog box.
3. Click OK.

The new Indicator Group displays in the Indicator Groups area. 

To add indicator items to an indicator group
1. Click New in the Indicator Items area.

The Indicator Item Definition dialog box will display.
2. Enter a valid expression in the Expression field and click Accept Expression.

Hint: If you do not know the expression, click the        (Look Up) button to search for a
specific data item or function.

3. Set the default sign from the Default Sign drop-down list, and modify the default
values of your expression by entering appropriate values in the Default Values and 
Increment fields.

Note: In instances where expressions could be classified as true or false, Boolean Operators (e.g.
True, False) are available. To activate this feature, click the Boolean check box.



When finished, click OK. Your new indicator item and indicator group should be highlighted,
and a checkmark should appear in the boxes next to them. Click OK to return to the Styles
tab of the Options dialog box. 

The same basic procedures are also used when customizing Item Sets. Item Sets are displayed on
the Report Assistant - Step 2 window and are used in developing reports and charts.

Importing/Exporting Styles
Many companies have a consistent set of screening criteria they use to identify investment
opportunities (e.g., investing in companies with a specific market capitalization, beta or P/E
range, or not investing in ADRs or specific industries). To create your own style template, follow
the instructions under “Choosing or Changing Styles.” When you reach the Options dialog
box, click Create New Style, then follow the instructions under “Customizing Indicators and
Item Sets.” Once your style template is created, click Export to save the file in a common
directory. To import a style template created by someone else, click Import. 
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Modifying Report Settings
From the Tools menu, select Options. In the Report tab, you can modify the settings used
when developing table reports. 

In the Field Defaults area, you can modify the fonts used in your report, the text background
color and the formula background color.

In the Table Defaults area, you can modify the number of columns that will be automatically
displayed when you create a new Table Report. You can also change the default settings of the
First Column Title and the First Column Formula.

In the Error Reporting area, you can determine whether or not error messages will display
when you are developing reports.

In the Saving Reports area, you can select whether or not you want to save your screen
association with your reports.
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Modifying Adjustment Factors

From the Tools menu, select Options. The Adjustment Factor tab is used to
automatically adjust per-share data (such as prices, dividends, and earnings per share) and share
data (such as common shares outstanding) for stock splits, stock dividends, and other capital
changes. Select an adjustment method from the drop-down list. Your choices are Ex-Date,
Pay-Date, or None. If you choose None, then no adjustment is made to per-share or share
data in your Research Insight applications. When an adjustment factor (Ex-Date or Pay-Date) is
not available, you can select one of the two following options from the @NA Adjustment
Factors area:

Use @NA Displays @NA (not available) for per-share data, share data, and the adjustment 
factor

Use 1.0 Displays unadjusted per-share and share data

The default is 1.0. 

When the Apply Current Adjustment Factor option is selected, you can apply the latest
available adjustment factor to per-share and share data; for example, if a stock split occurs after
the update of your core database, you can download the new adjustment factor from the
Internet, and it will be applied to per-share and share data.

When this option is turned off, even if you downloaded a more current adjustment factor from
the Internet, it will not be applied to per-share and share data. In addition, if you downloaded
prices from after the stock split, Research Insight will bring those prices into line with the pre-
stock split prices. Therefore, you will not see prices adjusted for the new stock split until you
update your core database.
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Modifying Data Code Settings

From the Tools menu, select Options. The Data Code Settings tab is used to modify the
Annual and Semiannual Figure Codes and the Insignificant Field which are used to specify the
treatment of annual, semiannual and insignificant figure data codes for quarterly data. These
data codes are collected in quarterly items when actual quarterly data is not available.

Modifying Current Period Cutoffs

From the Tools menu, select Options. The Period Reference tab is used to define the
current period cutoff for annual, quarterly, monthly, weekly, and daily data. Since a company's
current period depends on the last reported data of a company, you can define how far back in
time data is considered current. If you consider current annual data to be within the last three
fiscal years, then enter the number 3 in the Annual field.

Modifying Your Default Base Set

From the Tools menu, select Options. The Screening tab is used to change the Default
Base Set or the population (i.e. initial group of companies) against which your screening criteria
will be applied. Unless otherwise specified, the default set is $C which contains all actively
traded public companies on the COMPUSTAT (North America) database.



Although the majority of your analysis can be performed through the Research Assistant, there
may be times when you are building a custom report or chart or working in Research Insight’s
Classic window when you will want to incorporate formulas and functions.

A Formula is a mathematical or logical combination of components and operators that you
can build to extract information from the database or perform a calculation.

You can use formulas, in one form or another, in almost all of the applications you use in
Research Insight. Screens, reports, charts and spreadsheets all require formulas to extract the
information you need from the database. 

A Function is a pre-defined calculation that contains a combination of items, concepts,
companies, time periods and other functions.

This chapter shows you how to

• build your own formulas

• add wildcards to your formulas

• add functions to your reports, charts and screens
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Formulas in Research Insight
A formula is a mathematical or logical combination of one or more items, concepts, 
functions and operators that you can build to extract information from the database or 
perform a calculation.

You can use formulas in Research Insight to

• create screen criteria

• define data in your report or spreadsheet

• add data labels to your report or spreadsheet 

• create your own concepts

Formulas consist of combinations of different components and operators. The components tell
Research Insight what information it needs to retrieve or calculate. The operators tell Research
Insight how to read the formula and perform the calculation.

@PAVG(SALE,Y96,Y00)

function item time period reference

This formula calculates average sales over a five year period from fiscal year 1996 to fiscal 
year 2000.

Formula Components
Formula components tell Research Insight what information it needs to retrieve or calculate.
There are five different formula components: functions, items, company references, sets, time
period references and concepts. Each of these is explained in detail below.

Functions
A function is a pre-defined calculation. Functions can contain a combination of items, concepts,
companies, time period references and other functions. Each function begins with the @ symbol
and is followed by a short name. Each function also includes an argument. Arguments tell
Research Insight which variables to evaluate, enabling you to tailor each function for your
specific needs. 

Example
Function: @PAVG(formula, period 1,period 2)
Function with argument: @PAVG(EPSPX,-4,0)
What it does: Averages earnings per share over the last five years.
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Items
An item is a piece of information collected and stored in a database. Each item is identified by a
descriptive name and a mnemonic (abbreviated name). Research Insight contains hundreds of
data items covering a wide range of fundamental financial and market information.

Example
Item Name: Net Annual Sales
Item Mnemonic: SALE
What it does: This item represents gross sales (the amount of actual billings to

customers for regular sales completed during the period)
reduced by cash discounts, trade discounts, and returned sales
and allowances for which credit is given to customers.

Company References
Company references allow you to attach a company’s ticker symbol or GVKEY* to a formula so
that Research Insight will refer to that company’s data. When you include a company reference in
a formula, you’re telling Research Insight to retrieve or calculate that data for a specific company only,
regardless of other companies or sets that may be included in your screen, report, chart or spreadsheet.

Example
“IBM”:SALE Retrieves the current year net sales for International 

Business Machines Corp. (Using the ticker symbol.)
“11217”:AT[Y00] Retrieves total assets for 2000 for Volvo AB. (Using the GVKEY.)

* GVKEY identifies companies in the COMPUSTAT (Global) database.

Sets
A set is a collection of companies, segments, issues or currencies that share a common attribute.
All sets begin with a dollar sign ($) and are defined with a set name. Research Insight has an
extensive collection of pre-defined sets you can use or you can create your own. 

Example
$SP_500 A pre-defined set in the COMPUSTAT (North America) database that 

contains all of the current companies in the S&P 500 Index.
$F A pre-defined set in the COMPUSTAT (Global) database that 

contains active financial companies around the world.
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Time Period References
A time period reference tells Research Insight to retrieve a data value for a particular point in time
other than the current period. If you do not include time period references in your formulas,
Research Insight automatically uses the current period (or the most recently available data).

Example
(IB/SALE)[-3] Calculates the return on sales value for the period 3 years 

prior to the current period. If the current period for this 
company is 2000, this formula returns the value for 1997. 

Concepts
Concepts are mathematical or logical combinations of items and/or other concepts. They are
generally used to save time and increase accuracy when manipulating data in routine, repetitious
or complex expressions. Concepts do not contain values. They are mathematical calculations that
are evaluated each time you use them.While Research Insight contains more than 300 pre-defined
concepts, you can also create your own customized concepts or modify existing concepts.

Example
OANCF-DV-CAPX This concept is Operating Activities - Net Cash Flow minus

Cash Dividends minus Capital Expenditures, which is the 
calculation for Free Cash Flow.
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Formula Operators
Parentheses and mathematical and relational operators, often referred to as formula operators,
tell Research Insight how to read formulas and perform calculations. The following section
explains each of these operators in detail.

Parentheses
Parentheses make long formulas easier to read and ensure that Research Insight performs the
calculation in the appropriate order. The part of a formula enclosed in parentheses is always
performed first. If the parentheses contain other parentheses, the innermost set is calculated first.

Example
NI/((AT+AT[-1])/2) Calculates net income divided by the average total assets for 

the current and previous year.

If parentheses are not present, formula calculations are performed in the following order:

Precedence Operator
1 All functions
2 Exponentiation ( ^ )
3 Negation
4 Multiplication ( * ) and division ( / )
5 Addition ( + ) and subtraction ( - )
6 Relational operators

If your formula contains two or more operators with the same level of precedence, they are 
performed left to right.

Using Parentheses ( ), Brackets [ ], and Braces { }
When building formulas, it is important to know when to use parentheses, brackets and braces. 

Parentheses are used to establish hierarchy within mathematical calculations.

Example 1
(SALE[Y99]+SALE[Y00])/2 Adds annual sales for 1999 and 2000, and divides the 

result by 2.

Brackets are used for time period referencing.

Example 2
PRCCM[May99] Returns the monthly close price for May 1999.

Braces are used to create a temporary set of companies.

Example 3
{“dec”,“hwp”,“ibm”,“uis”} Temporary sets are sets created “on the fly” and not 

deliberately saved. 
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Mathematical and Relational Operators
Mathematical and relational operators allow you to combine or compare two or more item
values. These operators are consistent with mathematical conventions. 

Mathematical operators allow basic mathematical combinations of two values. You can use
mathematical operators with decimals, integers, time periods, dates and months. However, items
must be the same data type to calculate a valid result.

Mathematical Operators
+ Addition
- Subtraction
* Multiplication
/ Division
^ Exponentiation

Example
(SALE+SALE[-1])/2 Adds the current year’s annual sales to the annual sales 

of one year ago and divides the result by 2.

Relational operators allow you to compare 2 values. You can use relational operators with any
items, but they must be the same data type to calculate a valid result. The result of a relational
operator is either 1 (True) or 0 (False). 

Relational Operators
= Equal
< > Not equal
< Less than
> Greater than
< = Less than or equal to
> = Greater than or equal to

Example
SALE > 500 Returns a 1 (true) for a company with current period annual

sales greater than $500 million dollars.

Adding “Wildcards” to Your Formula
The Define Name option allows you to create a report or screen with “wildcard” formulas.
Wildcards allow you to generate varying report or screen results, depending on how you define
the wildcard. Examples of formulas with the Define Name option are shown below. 

Example 1
@CAVG(formula1,$SP_500) Averages whatever formula you enter (formula1) for $SP_500.

Example 2
“IBM”:formula2 Retrieves whatever formula you enter (formula2) for 

International Business Machines.
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Functions in Research Insight
A function is a pre-defined calculation that enables you to perform numerous tasks in your
reports, screens, charts or spreadsheets. Functions can contain a combination of items, concepts,
companies, time period references and other functions.

Research Insight contains more than 100 different functions that can be easily accessed through
the Look Up List (Tools Menu>Look Up>Function Tab). All functions are categorized according
to the type of analysis they perform. In this chapter, we’ll show you the different components of
a function and explain how these components work together to perform the calculation. We will
also introduce you to each function category and explain how each function performs its task.

The Parts of a Function
Each function begins with the @ symbol and is followed by an abbreviated name, such as PLSG
(least squares growth rate). Each function also includes an argument. Arguments tell Research
Insight which variables to evaluate, enabling you to tailor each function for your specific needs.
The function shown below contains a formula and a time period reference in the argument. 

@PLSG(formula,period 1,period 2)

function symbol        function name          function argument 

This function allows you to insert any formula and corresponding time references (beginning
time (period 1) and ending time (period 2)). Once you insert the argument, you’re ready to use
the function.

Research Insight categorizes all functions according to the type of analysis they perform. The
following sections explain each category in detail.

Currency Functions
Currency Functions are only used in the Global database and can be used to help you display
currency data the way you want to display it. Two examples of currency functions are shown
below. 

Example 1
Function: @NATIVE(formula)
Function with argument: @NATIVE(PRCCM)
What it does: Displays the monthly closing price in native currency.
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Example 2
Function: @SCALE(formula)
Function with argument: @SCALE(CEQ)/CSHO
What it does: Returns units of representation in millions. This 

function is useful for scaling those currencies 
presented in Research Insight in billions of currency units, 
such as the Japanese Yen or Italian Lira. Most other 
currencies are already presented in millions of 
currency units. If data for the company is already 
presented in millions of currency units, then the 
currency units remain in millions.

Growth Functions
Growth functions can be used to measure growth of an item over time. Research Insight 
contains several different growth functions to help you in your financial analysis. Two examples
of commonly used growth functions are shown below.

Example 1
Function: @FORECAST(formula,period 1,period 2,period 3)
Function with argument: @FORECAST(SALE,Y98,Y99,Y00)
What it does: Forecasts sales for 2000 based on 1999 and 1998 sales.

Example 2
Function: @PLSG(formula,period 1,period 2)
Function with argument: @PLSG(SALEQ,Q4Y95,Q4Y00)
What it does: Calculates quarterly sales growth for the quarterly periods 

between 4th quarter 1995 and 4th quarter 2000.
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Historical Analysis Functions
Historical analysis functions can be used to evaluate data over a period of time. All historical
analysis functions allow you to choose a beginning time (period 1) and an ending time (period
2). The examples below show you how you can use historical analysis functions to calculate a
company’s average earnings per share over the last five years, or calculate the median monthly
stock price over a 5-year period.

Example 1
Function: @PAVG(formula,period 1,period 2)
Function with argument: @PAVG(EPSPX,-4,0)
What it does: Averages earnings per share over the last five years.

Example 2
Function: @PMED(formula,period 1,period 2)
Function with argument: @PMED (PRCCM,-4,0)
What it does: Returns the median monthly close price over 5 years.

Example 3
Function: @EXPSMOOTH(weight,formula,period1,period2)
Function with argument @EXPSMOOTH(.9,SALE,-4,0)
What it does: Return the exponential average sales for 60 months.

Information Functions
Information functions return additional information about an item or abbreviate an item’s value.
For example, you can use the @ELEMENT function to return the inventory valuation method
for the second element in a multiple element item. Or, you can use the @DATE function to
insert a calendar date into a report. Two examples of information functions are shown below:

Example 1
Function: @ELEMENT(item,element)
Function with argument: @ELEMENT(INVVAL,2)
What it does: INVVAL is a multiple element item. In other words, 

there is more than one data value available for this 
item. By stipulating the number 2, you’re telling Research
Insight that you want to see the item’s second data value.

Example 2
Function: @DATE (YY,MM,DD)
Function with argument: @DATE(01,06,30)
What it does: Inserts the date 6/30/01 into a report.

Chapter 7 - Using Formulas and Functions

93



Logical Functions
Logical functions test items and formulas to determine whether or not they meet selected 
conditions. They are called logical functions because they evaluate a condition to be true or
false, and return data depending on specified conditions. You specify the argument for the
condition, and Research Insight displays the data as True (1) or False (0). These functions are
often used in screens, reports and spreadsheets, and are helpful when building financial models.
Two examples of logical functions are shown below

Example 1
Function: @VALUE(formula 1,formula 2,formula 3)
Function with argument: @VALUE(PRCCM, PRCCM[-1])
What it does: Retrieves the current monthly close price. If the current 

monthly price is not available, it retrieves the price from 
one month prior.

Example 2
Function: @INRANGE(formula,value 1,value 2)
Function with argument: @INRANGE(MKBK,1.0,2.0)
What it does: Finds those companies with a market to book ratio

between 1.0 and 2.0 (inclusive).

Mathematical Functions
Mathematical functions perform many of the same calculations that are possible with your
calculator, such as logarithms, square roots and exponents. Research Insight contains several
different functions to help you in your financial analysis. Two examples of mathematical
functions are shown below. 

Example 1
Function: @RND(formula)
Function with argument: @RND(PRCCM)
What it does: Rounds a price up or down to its nearest whole number.

For example, if an actual stock price is 15.25 this function
rounds and displays the price as 15.

Example 2
Function: @SQRT(formula)
Function with argument: @SQRT(144)
What it does: Calculates the square root of 144; the result is 12.
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Period Reference Functions
You can use period reference functions in conjunction with formulas to specify a time period for
which you want the formula evaluated. If you do not specify a time period with your formulas,
Research Insight uses current period data. Since companies may have different current periods,
these functions allow you to align items so that Research Insight displays data using the same
time period. Examples of period reference functions are shown below.

Example 1
Function: @MNT(period)
Function with argument: PRCCM[@MNT(0Q)]
What it does: Retrieves the monthly close price as of the last month 

of the current fiscal quarter.

Example 2
Function: @DAY(period)
Function with argument: @DAY(CPDQ)
What it does: Returns the last day of the current fiscal quarter.

Reference Functions
Reference functions tell Research Insight to refer to a particular geographic area, issue or
segment for the formula you’re evaluating. An example of a reference function is shown below.

Example
Function: @ISS(formula,number)
Function with argument: @ISS(PRCCM,2)
What it does: Returns the monthly price for the issue 2 of a company.
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Screening Functions
Screening functions save time by allowing you to create a set “on the fly” and change set types.
This means that you can apply any formula to a set other than just pre-defined or previously
saved sets. Examples of screening functions are shown below.

Example 1
Function: @CHGCO(set_type)
Function with argument: @CSUM(DVPSXM,@CHGCO(ISSUE))
What it does: Sums up the dividend per share for all issues of a company

Example 2
Function: @SET(base set,condition)
Function with argument: @SET($C,SIC=2834)
What it does: Screens the active U.S. companies database ($C) for companies in 

the pharmaceutical industry (SIC=2834).

Example 3
Function: @ISMEMBER(set_formula)
Function with argument: @IF(@ISMEMBER($SP_500),”*”,””)
What it does: In a table report, will print an “*” next to each company 

that is a member of the S&P 500.

Example 4
Function: @TRIMPCT(formula,percentage)
Function with argument: @CAVG(PEM,@SET($SP_500,@TRIMPCT(ROE,5)))
What it does: Returns average Return on Equity ratio for the S&P 500,

excluding values for companies that are within the top 
or bottom 5 percent.

Function with argument: @CAVG(ROE,@SET($SP_500,@TRIMPCT(ROE,1)=1))
What it does: The average ROE for the S&P 500 is 9.4.  

This average is distorted by a few outlying values; one
company’s ROE is over 4000 and another company’s ROE
is below -7000. If you trim off just 1% of the values,
the average ROE for the S&P 500 is 11.5.

Example 5
Function: @TRIMSTD(formula,trim_factor)
Function with argument: @IF(TRIMSTD(ROE,2),””,”*”)
What it does: Returns a “*” for each company whose Return on Equity

is more than 2 times the standard deviation away from the
base set’s mean.  The “*” lets you identify the outliers.
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Set Analysis Functions
Set Analysis functions allow you to find out information about set characteristics. For example,
you can use set analysis functions to find out how many companies are in a set or to average a
formula across an entire set. Examples of set analysis functions are shown below.

Example 1
Function: @CCOUNT(formula,set)
Function with argument: @CCOUNT(EPSPX[Y00],$C)
What it does: Counts the number of active U.S. companies with a value 

for earnings per share for 2000.

Example 2
Function: @CAVG(formula,set[match_formula])
Function with argument: @CAVG(PEM,$C,SECTOR)
What it does: Selects active companies out of a set that produce the same

sector for price to earnings monthly as the base company.

Example 3
Function: @CAVG(formula,set)
Function with argument: @CAVG(ROA,$MYSET)
What it does: Calculates the average return on assets for the 

companies in the set MYSET.

Example 4
Function: @CMED(formula, set, [match_formula])
Function with argument: (PEM/@CMED(PEM,$SP_500,GIND))*100
What it does: Calculates the relative P/E of a company vs. the median P/E 

of the S&P 500 companies in the same GICS Industry 
(6-digit GICS) as the subject company.

Example 5
Function: @NTILE(formula, num_fractiles, set)
Function with Argument: @NTILE(PEM,5,@SET($SP_500+@CHGCO(COMPANY),

@CHGO(COMPANY):GIND=GIND))
What it does: returns the quintile in which a company's P/E falls relative to its 

peers in the S&P 500 in the same GICS industry. This formula 
will work for any company whether it is on the S&P 500 or not. 
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Statistical Functions
Statistical functions provide you with the tools you need to generate statistical measures. For
example, you can use statistical functions to calculate a fractile or rank order within a set. Two
examples of statistical functions are shown below.

Example 1
Function: @FRAC(formula,set)
Function with argument: @FRAC(PI/SALE,$C )>.75
What it does: Identifies the companies in the database for which the 

pretax income to sales ratio ranks in the top 25%.

Example 2
Function: @RANK(formula,set)
Function with argument: @RANK(MKVAL,$SP_500)<=25
What it does: Ranks companies in the set $SP_500 based on market 

value and returns the top 25 companies.

Text Functions
Text Functions display the value of an item or formula in a textual format. For example, you can
use a text function to see the textual description of an SIC code, or you can use text functions to
find companies with specific characters in the company name. Examples of text functions are
shown below.

Example 1
Function: @DESC(value)
Function with argument: @DESC(SIC)
What it does: Displays the description of the SIC Code.

Example 2
Function: @FIND(find_text,within_text)
Function with argument: @FIND("CHEM",CONM)
What it does: In screening criteria, this returns companies with the 

characters CHEM anywhere in the company name. In 
a report formula, this returns a number representing the 
beginning character position. For example, in a screen, the 
company BIOCHEM INTERNATIONAL INC. would be 
included in the passed set. The same formula in a report would 
return the number 4.

Note: The @FIND function is case sensitive.
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Database Control Functions
Database Control Functions enable you to target or exclude a specific database layer, so you can
specify the type of data Research Insight will return. Examples of database control function are
shown below.

Example 1
Function: @DB(dbname,formula)
Function with argument: @DB(COMPUSTATDB,SALE[Y99])
What it does: Returns the value for SALE from the core database layer for 1999.

Example 2
Function: @EXCLUDEDB(dbname,formula)
Function with argument: @EXCLUDEDB(CLASSIC,GPMQ[Q2Y99])
What it does: Returns the gross profit margin - quarterly item from the first 

database layer it is found in, excluding the Classic layer, for the
second quarter of 1999. Research Insight reads sequentially 
through the database layers, and it will retrieve a value for GPMQ
from the first layer where it finds a value for the specified item.

Note: A time reference is required in order for Research Insight 
to retrieve the correct data.



Research Insight automatically evaluates the most recent data available when you run a database
screen, report or chart, unless you include a time reference to a specific historical period. When
selecting a time period reference, keep in mind that data in the COMPUSTAT databases is
collected according to established periodicities, or the time periods for which an item is reported
and available.

This chapter

• details periodicities for which data is available

• explains absolute, relative, calendar time period references 
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Annual Periodicity
Two different types of annual data are available: fiscal year data and calendar year data.

Fiscal Year Data
A fiscal year is an accounting period of twelve months. A company’s fiscal year corresponds to 
the calendar year in which it has the most overlap in months. For example, if a company’s 
fiscal year-end is March 2001, the data in its annual report represents the company’s operations
for nine months of 2000 and three months of 2001. The data would be classified as fiscal 
2000 data.

Fiscal years ending in January through May are assigned to the calendar year in which the fiscal
period began. Fiscal years ending in June through December are assigned to the calendar year in
which the fiscal period ends.

To determine in which month a company ends its fiscal year, use the fiscal year item, FYR, in
your applications. Research Insight returns a data value of 01 through 12 to represent the
months January (01) through December (12).

Calendar Year Data
A calendar year spans from January 1 to December 31. Some annual items, such as high, low,
and close prices, shares traded and Fortune 500 codes are collected on a calendar year basis.
Companies report these items by December 31 each year.

The calendar year for each company is that in which its fiscal period ends. Research Insight
provides the capability to retrieve the annual data of companies with different fiscal periods on a
calendar basis. This is done by using calendar time period references, and explained later on in
this chapter. For example, using a calendar time period reference of [C00], you can retrieve the
fiscal 1999 data of a May fiscal year-end company (the period ended May 1999) and the fiscal
2000 data of a December fiscal year-end company.
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Quarterly Periodicity
Quarterly data is reported on a fiscal quarter basis.

Fiscal Quarter Data
A fiscal quarter is an accounting period of three months. The first three months of the fiscal year
comprise the first fiscal quarter, the second three months comprise the second fiscal quarter, and
so on. A company’s annual and quarterly fiscal year-end can be different if a company reports a
fiscal year change. Otherwise, these two accounting periods for a quarterly company should be
the same. You can use the fiscal year item, FYRQ, in your applications to determine which
month a company ends its fiscal year. Research Insight returns a data value of 01 through 12 to
represent the months January (01) through December (12).

Monthly Periodicity
Monthly data is reported on a calendar monthly basis.

Daily Periodicity
Issue market data is reported on a daily basis.

Scalar Periodicity
Scalar data is data that is unrelated to time, such as a company’s headquarters address or
telephone number.
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The Current Period
We refer to a company’s most recently available data as “current period data.” Since companies
report their financial statements at different times throughout the year—the reporting month
being the fiscal year-end—the most current available data for a given company reflects its fiscal
year.

As you work with Research Insight, keep in mind two points. First, companies have different
fiscal years and therefore potentially different current periods. Second, unless you define the
time period you are interested in, Research Insight will return current period data. These points
become important when you are working with multiple companies or sets of companies. To
ensure that you are evaluating the same time period for each company in a set, you should
specify time period references in your formulas. 

The following report shows you quarterly sales for companies in the S&P 500. By using the
Current Period-Quarterly item (CPDQ), you’re able to determine the current quarter for each
company, and by using the Fiscal Year item (FYR) you’re able to determine in which month a
company ends its fiscal year. As you can see, the current quarter varies depending on the fiscal
year-end of the company.
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You may find that some quarterly items display a Not Available (@NA) code if you try to
retrieve the current quarterly period. This is because some companies only report selected data
on a preliminary basis in the Wall Street Journal Digest of Earnings, on the newswire services or
in a press release. When any type of company data is entered for a quarterly period, that period
is considered the current quarterly period. If this occurs, use the data for the previous quarter, as
it is the most recent data available.

Research Insight may also display Not Available codes if you try to retrieve current period data
for a research (inactive) company. Since research companies no longer report data, no
information is available after the date of a research company’s last financial report. To retrieve
data for a research company, you must reference a time period before the company stopped
reporting, or change the Research Insight program defaults and redefine how far back in time
data should be considered current. To change these defaults, simply select the Current Period
tab from the Options dialog box under the Tools menu and define the current period cutoffs.
For example, if you consider current annual data to be within the last four fiscal years, then
enter a 4 in the Annual field.

To determine whether or not company data has been recently updated, you can use the
update code items, UPD or UPDQ. A 0 update code will appear for those years or quarters
before data is available for a company. For example, if a company went public in 1995, all
years prior to 1995 would have a 0 update code. A 1 update code indicates that the company
has not been updated for a given year or quarter and that the only data available will be the
Adjustment Factor (Cumulative) and, in some cases, market data such as price and/or
dividend information. A 2 update code indicates that the company has been updated from a
preliminary source, but additional data is expected to become available. A 3 update code
indicates that the company has been updated from its final source (usually a 10-K or 10-Q),
and no further data will be available.
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Time Period References
A time period reference is a tool you can use in your formulas to extract data for one of the
specific periodicities. Time period references tell Research Insight to retrieve data for a particular
point in time other than the current period. For example, suppose you’re building a report to
display the December 2000 stock price for several companies. By attaching a time period
reference to the Price-Close Monthly item, you’re telling Research Insight to retrieve data for
that particular time period. If you don’t attach a time period reference, Research Insight
automatically retrieves data for each company’s current period.

There are three different types of time period references: absolute, relative and calendar. The
following section explains the differences.

Absolute Time Period References
Absolute time period references retrieve data for a specific date or time period. Examples of
absolute time period references are shown below.

Fiscal Year Example
(IB/SALE)[Y00] Returns fiscal year 2000 return on sales.

Fiscal Quarter Example
(COGSQ/SALEQ)[Q2Y01] Returns cost of goods sold to sales ratio for the 2nd 

fiscal quarter of 2001.

Month-end Example
PRCCM[MAR01] Returns the close market price for March 2001.
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Relative Time Period References
Relative time period references retrieve data according to how far back in history from the
present time you want to go. In other words, relative time period references enable you to
retrieve data for a specific time period relative to the current time period. The current period for
each company is the most recent period in which any data is available for that periodicity
(annual, quarterly, etc.) Current period time references are implied [0]. Therefore, one period
prior to current is indicated by [-1], two periods prior to current is indicated with [-2], etc. 

Examples of relative time period references are shown below:

Annual Example
(IB/SALE)[-3] Returns the return on sales value for the period 3 

years prior to the current period. If the current 
period for this company is 2000, this formula 
returns the value for fiscal year 1997. 

Quarterly Example
CSHOQ/CSHOQ[-1] Returns the value for quarterly shares outstanding 

for the current quarter divided by the quarterly 
shares outstanding for the prior quarter.

Monthly Example
PRCCM/PRCCM[-12] Returns the monthly close price from the current 

month divided by the monthly close price from 12 
months ago. For example, you could use the price 
from January of the current year divided by January 
of the prior year.

Weekly Example
AJPW[-3] Returns the weekly adjustment factor from 3 weeks 

prior to the current period.

Daily Example
@PAVG(PRCCD,-49,0) Returns a 50-day average daily close price.
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Calendar Time Period References
Calendar references retrieve data for the same approximate time frame for companies with
different fiscal periods. The calendar time period reference is always the exact year in which the
time period ends. For example, suppose a company’s fiscal year-end is May 2000. The calendar
time period for annual data is 2000.

The fiscal time period for the same company is different. If you evaluate monthly time periods
for annual data ending May 2001, you’ll see that seven of the 12 months are from the year
2000. Therefore, the fiscal time period for annual data is 2000. Examples of calendar time
period references are shown below.

Calendar Year Example
SALE[C00] Returns the annual sales value reported in calendar 

year 2000. This may not be the sales value for the 
2000 fiscal year for the company.

Calendar Quarter Example
@PSUM(XINTQ,I00,IV00) Returns the sum of quarterly interest expense values 

for the 1st through the 4th calendar quarters of 2000. 
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Using Calendar Quarters to Align Different Fiscal Periods
Calendar quarter references allow you to compare data from the same approximate time frame
regardless of the company’s fiscal year. When you include a calendar quarter reference in a
formula, you tell Research Insight to align fiscal years and quarters to calendar time.

The following chart shows various companies’ fiscal years, a sample of one of the fiscal year’s
quarters, the months that comprise that fiscal quarter, and the appropriate calendar quarter
reference.

Fiscal Year FY Quarter Months in FY Quarter Calendar Quarter Reference
12 FYR (Dec) 3 July, August, September III
06 FYR (June) 1 July, August, September III
02 FYR (Feb) 2 June, July, August III
07 FYR (July) 1 August, September, October III

Suppose you want to display the quarterly sales data for several companies in a report, and each
of the companies has a different fiscal year (and different fiscal quarters). By attaching a calendar
quarter reference to the Sales-Net Quarterly item (SALEQ[III97]), you tell Research Insight to
display the quarterly sales data for the same approximate time even though all of the companies
have different fiscal years.
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Using Period Reference Functions to Align Items to
Different Periodicities

Research Insight provides you with functions that you can use in your formulas to align items to
different periodicities. Examples of period reference functions are shown below.

Day to Month Example
PRCCD[@DAY(0M)] Returns the price on the last day of the 

current month.

Month to Month Example
PRCCM[@MNT(0Y,12)] Returns the monthly close price as of December of 

each company’s current year. 

Month to Quarter Example
PRCCM[@MNT(0Q)] Returns the monthly close price as of the last month 

of the current fiscal quarter. 

Month to Year Example
PRCCM[@MNT(0Y)] Returns the monthly close price as of the last month 

of the current year.

Quarter to Year Example
CSHOQ[@QTR(0Y)] Returns the quarterly shares outstanding as of the 

end of the current annual period (4th quarter).



The Library is an integral component of Standard & Poor’s Research Insight that allows you to
access textual databases including Business Descriptions, Standard & Poor’s Trends and
Projections and DRI•WEFA Country Overviews. The Business Descriptions database is
available for all COMPUSTAT (North America) and COMPUSTAT (Global) subscribers. The
Trends and Projections publication is available for all North America subscribers, while
DRI•WEFA Country Overviews are available for all Global subscribers. 

This chapter shows you how to

• access Business Descriptions through Research Insight

• access Trends and Projections through Research Insight

• access Country Overviews through Research Insight

• view textual data from an open set
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Accessing Business Descriptions Through
Research Insight

Business Descriptions are brief textual descriptions of a company’s business operations. The
information is compiled by Standard and Poor’s analysts and is continually updated. Business
Descriptions are displayed in Notepad as text (.txt) files. The following example demonstrates
how you would open a Business Description for Polaris Industries Inc.

Begin from the Research Insight desktop.

1. Click the        Library button. 
You will see the Select Company dialog box.

2. Enter the company’s ticker symbol (pii) in the Enter Ticker field.

Hint: Global companies are identified by GVKEYs. The         (Look Up) button will help
you locate company ticker symbols and GVKEYs.

3. Click OK.
You will see the Document List dialog box.

4. Select Business Description from the list (Global customers should select GV 
Business Descriptions.)

5. Click OK.
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You will see the Business Description of the company you selected in a separate notepad 
window.

Note: You can now import shortened Business Descriptions directly into Excel. Refer to
Chapter 9 - Creating Reports in Excel, of the Beyond Basics manual.

Batch Printing Business Descriptions
You can easily print Business Descriptions for multiple companies or a set of companies by
using the batch print feature.

Begin from the Research Insight desktop.

1. Click the       Library button. 
You will see the Select Company dialog box.

2. Click the Batch Print Button.
You will see the Set Formula dialog box.

3. Enter a string of ticker symbols, separated by commas, in the Companies field, or enter 
a set in the Set Formula field.

4. Click OK.
A Business Description will print for each company you entered, or for each company in
the set you entered.
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Accessing Trends & Projections Through Research Insight
Trends and Projections is a monthly publication by David M. Blitzer, Managing Director and
Chief Investment Strategist of Standard and Poor’s, covering current economic issues. It is
displayed as a .pdf document. 

Begin from the Research Insight desktop.

1. Click the        (Library) button.
You will see the Select Company dialog box.

2. Enter a company ticker symbol in the Enter Ticker field.

Hint: The        (Look Up) button will help you access company ticker symbols.

3. Click OK.
You will see the Document List dialog box.

4. Select Trends and Projections from the list and click OK.
You will see the most recent publication of Trends and Projections.
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Accessing Country Overviews Through Research Insight
The Country Overviews database contains economic information and forecasts for more than
100 countries. Country Overviews are displayed as a .pdf document. 

Begin from the Research Insight desktop.

1. Click the       (Library) button.
You will see the Select Company dialog box.

2. Enter a company GVKEY in the text box. 

Hint: The         (Look Up) button will help you access company GVKEYs.

3. Click OK.
You will see the Document List dialog box.

4. Select Country Overview from the list and click OK.
You will see the Country Overview, for the country in which your company is 
incorporated.

Hint: To access additional Country Overview documents, click the       (Library) button and
repeat Steps 2-4.  
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Viewing Textual Data From an Open Set
Research Insight makes it easy to view textual data for any company within an open set. Simply
clicking a button provides instant access to textual information for any company you choose.

Begin from the Research Insight desktop.

1. Click the        (Open Set) button.

2. Select a set and click Finish.
You will see the selected set.
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3. Highlight the company that you want to view textual data for and click 
the       (View Text) button.

You will see the Document List dialog box.

4. Select a document and click OK.
You will see the document you selected.



One of the most powerful features of Standard & Poor’s Research Insight is its ability to
communicate with Microsoft Excel® through Active-X Technology. Excel requests data from the
Research Insight database and the exchange between the two applications takes place so quickly
that you immediately see the requested data displayed in the Excel spreadsheet. You can view
Research Insight Reports and Charts directly in Excel, and create your own spreadsheets in Excel
using all of the features and data available in Research Insight. The link between Excel and
Research Insight brings you the power of both applications. 

This chapter shows you how to

• use a Research Insight set to create an Excel spreadsheet

• open a Research Insight report as an Excel spreadsheet

• use Excel and the Report Assistant to create a spreadsheet

• open an Excel template created with Research Insight

• open a Research Insight chart in an Excel spreadsheet

• use Excel and the Chart Assistant to create a chart

• Add-in functions in Excel
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Using the Research Assistant to Create an
Excel Spreadsheet

Let’s create a set of companies with the same SIC classification as Adobe Systems and a monthly
market value over $1 billion. Our Excel spreadsheet will list the company names, their ticker
symbols and their net annual sales.

Begin with Excel open.

1. From the S&P menu, select Research Assistant.

You will see the Research Assistant - Step 1 window on top of Excel.
2. Enter the ticker symbol for Adobe (adbe) in the Companies field. 
3. Highlight SIC under the Find Similar Companies list.
4. Under the Valuation tab, click the Market Value check box and click Next.
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Hint: If the tabs or checkboxes you need are not displayed, click Customize and select the
Items you need from the Item Group category. Click OK and choose whether or not to
save your changes.

The set of companies that passed the screening criteria will display on the Research 
Assistant - Step 2 window.

5. Click Next.
6. Click Next again. You will see the Report Assistant - Step 1 window.
7. Click the Items vs. Companies radio button under Current Time Period.
8. Click Next. You will see the Report Assistant - Step 2 window. 
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9. Click the Income - Ann radio button and select the Sales item.
10. Click Add.
11. Enter tic (the mnemonic for ticker symbol) in the New Item field and click the        

button.

Hint: To search for an item to add to your spreadsheet, click the       (Look Up) button.

12. Click Finish.
You will see your spreadsheet in Excel.

Hint: Click the        (Run) button to open the Run Assistant window where you can change
your initial set, or modify your base set and criteria. Close the Excel book before
continuing with the next procedure.
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Opening a Research Insight Report as an Excel
Spreadsheet

It’s easy to open a Research Insight report and view it as a spreadsheet in Excel. Let’s open
a Quarterly Balance Sheet for Albertsons Inc., Safeway Inc., Kroger Co., and Winn-Dixie 
Stores Inc.

Begin with Excel open.

1. From the S&P menu, select Open Report.
You will see the File Open window.

2. From the Balance Sheets folder, select Quarterly Balance Sheet and click Finish.
You will see the Run Assistant window.

3. Enter your target companies’ ticker symbols in the Companies field, separating each 
ticker symbol with a comma (abs,swy,kr,win).

4. Click OK.
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You will see the Quarterly Balance Sheet for Albertsons Inc. in Excel.

Hint: To view the report for the other companies, select the company from the drop-down list
directly above the report. Click the        (Run) button to open the Run Assistant
window, where you can modify the criteria used to create the spreadsheet. Close the 
Excel book before continuing with the next procedure.
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Using Excel and the Report Assistant to Create a
Spreadsheet

It’s easy to create a spreadsheet using Excel and the Report Assistant. Let’s create a spreadsheet
that shows the market value monthly, sales 3 year compound annual growth rate and net sales
for the companies in the previous example.

Begin with Excel open.

1. From the S&P menu, select Report Assistant.
You will see the Report Assistant - Step 1 window on top of Excel.

2. Select the Items vs Companies radio button under Current Time Period.
3. Click Next.
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You will see the Report Assistant - Step 2 window.

4. Click the Valuation radio button.

Hint: If the radio buttons you need are not displayed, click Customize and select the Items
you need from the Item Group category and Item List box. Click OK, and choose
whether or not to save your changes.

5. Select the Market Value-Mnthly item and click Add.
6. Click the Growth radio button.
7. Select the Sales 3 Yr CAGR item and click Add.
8. Select the Income - Ann radio button.
9. Select the Sales item, click Add and click Finish.

You will see the Run Assistant window.
10. Enter your target companies’ ticker symbols in the Companies field, separating each 

ticker symbol with a comma (sbux,farm,peet).
11. Click OK.

You will see the spreadsheet in Excel.

Hint: Close the Excel book before continuing with the next procedure.
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Opening an Excel Template
Research Insight includes more than 60 templates for backtesting, debt analysis, market and
performance summary, portfolio analysis and more. You can also use this example to open a
spreadsheet you have previously created and saved.

Begin by opening Excel.

1. From the S&P menu, select Open Template.
You will see the File Open dialog box.

2. Select Company Snapshot and click Finish
The selected spreadsheet displays in Excel.

Hint: Close the Excel book before continuing with the next procedure.
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Open a Research Insight Chart in an Excel Spreadsheet
Let’s open a Line of Business - Sales chart for General Electric.

Begin with Excel open.

1. From the S&P menu, select Open Chart.
You will see the File Open window on top of Excel.

2. From the Line of Business folder, select Line of Business - Sales and click Finish.
You will see the Run Assistant window.

3. Enter General Electric’s ticker symbol (GE) in the Companies field. 
4. Click OK.



You will see the Line of Business - Sales chart in Excel.

Hint: Click the         (Run) button to open the Run Assistant window, where you can modify
the criteria used to create the chart. Close the Excel book before continuing with the next
procedure.
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Using Excel and the Chart Assistant to Create a Chart
It’s easy to create a chart using Excel and the Chart Assistant. Let’s create a chart that shows the
Net Sales and Cost of Goods Sold for the last three years for Proctor & Gamble. 

Begin with Excel open.

1. From the S&P menu, select Chart Assistant.
You will see the Chart Assistant - Step 1 window on top of Excel.

2. Select the Bar radio button under Chart Style.
3. Select the One Company radio button under Companies per Chart.
4. Select the Historical Analysis radio button under Periods.
5. Click Next.
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You will see the Chart Assistant - Step 2 window.

6. Click the Income - Ann radio button.
7. Select the Sales item and click Add.
8. Select the Cost of Sales item, click Add and click Next.

You will see the Chart Assistant - Step 3 window.

9. Click the Absolute radio button.
10. Enter Y97 in the Beginning Period field.
11. Enter Y00 in the Ending Period field and click Finish.

You will see the Run Assistant window.
12. Enter the ticker symbol for Proctor & Gamble (pg) in the Companies field.
13. Click OK.
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You will see the chart in Excel.

Hint: Click the        (Run) button to open the Run Assistant window, where you can modify
the criteria used to create the chart. Close the Excel book before continuing with the next
procedure.
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Add-in Functions in Excel 
In this section, we’ll discuss advanced Active-X Technology capabilities known as add-in
functions. Add-in functions make it easy to retrieve company data from the North America and
Global databases and use it in your Excel spreadsheet. Add-in functions evaluate arguments and
display either single item values or a range of item values (also known as a data array). The six
add-in functions listed below allow you to create your own templates in Excel. 

Hint: When entering add-in functions into a spreadsheet, you must include the function
arguments (shown in italics).

=spws(key, expression)
Displays a single data value in one cell for a single company.

Example =spws(“ibm”,“sale”) 
Displays current sales for IBM.

=spws_set_size (“set”)
Displays the number of companies in a set.

Example =spws_set_size(“$myset”)
Displays the number of set members in the set, “myset”.

=spws_set(set,expression,array_direction)
Displays a single data value for each member of a set
of companies.

Example =spws_set(“$myset”,“sale”, “down”)
Displays the total net sales for each member of the set, “myset”.
Excel displays the item values downward in a column. If you 
enter “across” into the function, Excel will display the item values
across in a row.

=spws_time_series(key,expression,
begin_period,end_period,array_direction)
Displays a data value over a period of time (an array) for a 
single company.

Example =spws_time_series(“ibm”,“sale”,“-4y”,“0y”,“down”)
Displays the total net sales for the most recent 5 years for
International Business Machines Corp. Excel displays the data
values in the column beginning with the fifth year of data 
and ending with the most recent year of data.

Chapter 10 - Using Standard & Poor’s Research Insight with Excel

133



=spws_set_sort(set,”expression”,”sort variable”,
”sort direction”,”array_direction”)
Sorts a set of companies based on your screening criteria.

Example =spws_set_sort (“$myset”,”conm”,”oppe”,”a”,”down”)
Sorts the company names in $MYSET in ascending order by 
Price/EPS from Operations.

=spws_screen(“screen”,”set”,”date”)
Runs a saved screen and returns a set of companies that pass 
your investment criteria for a given time period.

Example =spws_screen(“test.scn”,”test.set”,”dec96”)
Runs the test.scn screen as of December 1996 and saves the
companies that passed the criteria to the set “test.set”. Then,
reference the $test.set in another function: for example, you 
could find the average one year return for the set a year later, in
December 1997.

The last four add-in functions listed (=spws_set, =spws_time_series, =spws_set_sort and
=spws_screen) are also referred to as array formulas. Array formulas perform calculations that
produce multiple results or perform calculations for a group of arguments arranged in rows or
columns.  You can use array formulas to take the place of several single-value formulas. This will
reduce the amount of time you spend typing repetitive formulas. You will recognize array
formulas because they are surrounded by brackets ({ }) in the Formula Bar.

Because an array shares only one formula, you must edit an array differently from ordinary
cells. When you edit an array, you edit the entire range at once as if it were a single cell. To do
this, simply highlight the range, enter the new contents in the Formula bar and press the Ctrl,
Shift and Enter keys simultaneously. 

To edit an existing array, select any cell in the array and press Ctrl and / simultaneously. This
will select the entire array for you. Edit the formula and press Ctrl, Shift and Enter to update
the data.
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Importing is one of the timesaving features of Standard & Poor’s Research Insight. You can use
the Task Scheduler to import or download files during your off-hours and optimize the time you
spend at the office.

You can also incorporate your own data, companies and concepts into Research Insight directly
from any application that can create a delimited ASCII file.

This chapter shows you how to

• use the Task Scheduler

• import data into Research Insight

• import sets into Research Insight

• import concepts into Research Insight

135

Chapter 11
Importing and
Downloading



Using the Task Scheduler
Note: For network users. Only Network Administrators should use this feature. For further

network usage recommendations, please refer to “Sharing Databases on a Network” in
Standard & Poor’s Research Insight Beyond Basics manual.

The Task Scheduler was designed to save you time when importing or downloading large files into
Research Insight. You can import your own files or download files from the Internet. All you have
to do is specify which files you want to import or download and the date and time you want the
task performed. The Task Scheduler does the rest. The files you import or download will be added
to the write-to databases. (For more information on write-to databases, see “Managing Your
Databases” of the Standard and Poor’s Research Insight Beyond Basics manual.)

Scheduling an Import
Research Insight makes it easy for you to schedule an import for your own files.

Begin from the Research Insight desktop.

1. From the Tools menu, select Task Scheduler.
You will see the Task Scheduler dialog box.

2. Click the New Task button.
You will see the New Schedule Entry dialog box.

3. The Import radio button should be selected by default, so simply click OK.
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You will see the Schedule Import dialog box.

4. Select User Data, User Sets or Economic Data from the Define Import area.

Hint: Click the Browse button and select the drive and directory where the file is stored.
This information will be reported in the source field.

5. Click the Text Options button. You will see the Text Options dialog box.

6. Select the column delimiter type used in the import file and click OK. The column 
delimiters are as follows:

Tab Delimits columns with tabs.
Comma Delimits columns with commas.
Space Delimits columns with spaces.
Semicolon Delimits columns with semicolons.
Custom Delimits columns with a custom character.
Use Quotes Encloses text with quotes.
Use Labels Includes labels at the top of each column.
Fixed Field Delimits columns with a specified number of spaces. Enter the number

of spaces you want your columns separated by in the text box.

Hint: If you select the Use Labels option, Research Insight will include labels at the top of
each column in a table report, but not in a free-form report.
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7. If you like, enter a description of your file in the Description field.
8. Schedule your import. Select either Now, One Time, Upon New Data File or 

Periodically from the Schedule area of the Schedule Import dialog box.

Now Research Insight will import your file as soon as you close the Task 
Scheduler.

One Time Research Insight will import your file at a specific date and time. Once 
you select this option, you will be able to select the date and time you 
want your file imported.

Upon New At startup, Research Insight will look for a more current data file 
Data File compared to the date of the file at setup time, or compared to the last 

data file imported. Once you select this option, you will be able to 
specify the time that you want Research Insight to begin searching for 
a new file.

Periodically Research Insight will import your file either daily, weekly, or monthly at 
a specific time. Once you select this option, you will be able to schedule 
the time you of day you want your file imported and the date you want 
the import to begin.

9. When you are satisfied with your selections, click OK.
You will return to the Task Scheduler dialog box. The import you just scheduled will appear
in alphabetical order in the list of Scheduled Tasks.

Hint: When you schedule multiple tasks, Research Insight will import files according to the
order of the time scheduled, regardless of the length of time needed to import each file.
For example, if you schedule one import at 11:00 p.m. and another at 11:15 p.m., and
the first import takes 20 minutes, Research Insight will import the second task
immediately after the first task is finished.

10. When you are finished scheduling imports, close the Task Scheduler dialog box.

Important: In order to import data, Research Insight must be running, so do not close
Research Insight if you have an import scheduled.
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Changing the Import Schedule
From time to time, you may want to alter the import schedule previously established. Research
Insight makes changing this schedule a simple process.

Begin from the Research Insight desktop.

1. From the Tools menu, select Task Scheduler.
You will see the Task Scheduler dialog box.

2. Highlight the task you want to change and click the Update Task button.
You’ll see the Schedule Import dialog box.

3. Make your changes to the import schedule and click OK.
You will return to the Task Scheduler dialog box. The import you just rescheduled will 
appear in alphabetical order in the list of Scheduled Tasks.

4. When you are finished scheduling imports, close the Task Scheduler dialog box.

Important: Research Insight must be running in order to import data.
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Scheduling an Internet Download
Research Insight makes it easy for you to schedule a download for fundamental and Value 
Added data from the Internet.

Begin from the Research Insight desktop.

1. From the Tools menu, select Task Scheduler.
You will see the Task Scheduler dialog box.

2. Click the New Task button.
You will see the New Schedule Entry dialog box.

3. Click the Internet Download radio button and click OK.
You will see the Schedule Internet Download dialog box.

4. Select the file or files you want to download from the File Types area. These files are 
described below.

Daily Prices Contains market data such as daily prices, adjustment factors, 
common shares traded, and dividends per share.

Fundamentals Contains fundamental company information such as sales, net 
income and operating earnings per share. Also contains 
fundamental financial data, per share data and ratios for the
S&P indexes.

Value Added Data The Value Added database consolidates the sector, economic 
sector, non-active sector and Value/Growth Indicator files. It 
also includes IPO Date, Industry Sector Code–Historical, 
Economic Sector Code—Historical, Index Fundamentals, 
Insider Trading and Institutional Ownership data items.
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FIRST CALL Contains two quarters and two fiscal years of FIRST CALL
Consensus consensus earnings estimate data, expected report dates, 

consensus recommendations, future growth rates, earnings 
surprise data, operating actual earnings, and P/E ratios.

FIRST CALL Contains earnings estimate consensus trends and estimate 
Revisions revision momentum.
COMPUSTAT(Classic) Contains non-restated, quarterly COMPUSTAT data 

as it was originally collected by Standard & Poor’s.
EVAntage Contains Stern Stewart’s proprietary EVA model data.

5. Specify the number of days worth of data you want to download or select the All days
needed option. This option is selected by default and automatically downloads the
appropriate number of days’ worth of data necessary to complete your fundamental data file.

6. If you’re downloading one of the FIRST CALL estimates files, you can specify whether you
want to download the entire file or only the changes that have been made to a file since
your last download. To download the entire file, click the Full radio button. To download
the changes, click the Differences radio button.

Hint: Unless you download FIRST CALL data on a daily basis, we recommend that you
download the entire file or keep All days needed selected to ensure you are using the
most current data available.

7. Schedule the time you want your file downloaded. Select either Now, One Time, or
Periodically from the Schedule area of the dialog box.

Now Research Insight will download your file as soon as you close the 
Task Scheduler.

One Time Research Insight will download your file at a specific date and time.
Periodically Research Insight will download your file either daily, weekly, or monthly 

at a specific time.

8. When you are satisfied with your selections, click OK.
You will return to the Task Scheduler dialog box. The download you just scheduled will 
appear in alphabetical order in the list of Scheduled Tasks.

Hint: When you schedule multiple downloads, Research Insight will download files according
to the order of the time scheduled, regardless of the length of time needed to download
each file. For example, if you schedule one download at 12:00 a.m. and another at 12:15
a.m., and the first download takes 20 minutes, Research Insight will download the second
task immediately after the first task is finished.

9. When you are finished scheduling downloads, close the Task Scheduler dialog box.

Important: In order to download data, Research Insight must be running, so do not close
Research Insight if you have a download scheduled.
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Establishing Your Internet Settings
In order to download data, you need to have a connection to the Internet. The first time you
open the Schedule Internet Download dialog box, Research Insight will ask for your User Name
and Password. You may also need to enter proxy settings, depending on whether you access the
Internet through a firewall at your organization (check with your organization’s Network
Administrator).

The Internet Download Settings dialog box is shown below.

Changing the Internet Download Schedule
From time to time, you may want to alter the Internet download schedule previously
established. 

Begin from the Research Insight desktop.

1. From the Tools menu, select Task Scheduler.
You will see the Task Scheduler dialog box.

2. Highlight the task you want to change and click the Update Task button.
You will see the Schedule Internet Download dialog box.

3. Make your changes to the download schedule and click OK.
You will return to the Task Scheduler dialog box. The download you just scheduled will 
appear in alphabetical order in the list of Scheduled Tasks.

4. When you are finished scheduling downloads, close the Task Scheduler dialog box.

Important: Research Insight must be running in order to download data.
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Suspending a Scheduled Task
When a task is suspended, all of the scheduling information is saved and can be activated again.

Begin from the Research Insight desktop.

1. From the Tools menu, select Task Scheduler.
You will see the Task Scheduler dialog box.

2. Highlight the task you want to suspend and click the Activate/Suspend button.
The Task Scheduler suspends the highlighted task from the list of scheduled tasks. To
activate this task again, simply highlight the task and click the Activate/Suspend button.

3. When you are finished, close the Task Scheduler dialog box.

Deleting a Scheduled Task
Once you decide that you have no further need for a scheduled task, you can delete it from the
list of scheduled tasks.

Begin from the Research Insight desktop.

1. From the Tools menu, select Task Scheduler.
You will see the Task Scheduler dialog box.

2. Highlight the task you want to delete and click the Delete Task button.
Research Insight asks if you are sure you want to delete the selected tasks.

3. Click Yes.
The Task Scheduler deletes the highlighted task from the list of scheduled tasks.

4. When you are finished, close the Task Scheduler dialog box.
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Viewing Import and Download Results
For your convenience, the Task Scheduler records all completed activities in a log file. This file
shows you information such as the name of the file imported or downloaded, and the date and
time the import or download started and finished.

Begin from the Research Insight desktop.

1. From the Tools menu, select Task Scheduler.
You will see the Task Scheduler dialog box.

2. Click the View Log button.
You will see the Schedule.log file.

3. When you are finished viewing the import or download results, select Exit from the 
File menu.
You will return to the Task Scheduler dialog box.

4. When you are finished, close the Task Scheduler dialog box.
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Importing Your Own Data into Research Insight
You can use the importing feature to incorporate data items and values into Research Insight.
This section shows you how to import data from a delimited ASCII file into Research Insight.

There are three steps involved in importing your own data: creating your spreadsheet file, saving
and importing the data from your spreadsheet file into Research Insight.

Creating Your Spreadsheet
To create your spreadsheet file, open a new document in Excel. Create the table header by
entering labels in the first row of the spreadsheet. First, enter the retrieval key (e.g., ticker
symbol) in cell A1. The different types of retrieval keys you can use are listed below. Next, in
cells B1 and across, enter the data that corresponds to the data item mnemonic, the time period
and the specific company ticker symbol in each cell. An example is given below.

Retrieval Keys
Valid retrieval keys are listed below.

TIC The company’s ticker symbol.
CUSIP The company’s CUSIP number, a 9-digit number.
GVKEY The company’s primary key in the Global database.
Currency Code A currency key used for the Global database.

If you want to import an Issue, Business Segment or Geographic Segment, enter the ticker
symbol, a backslash, the appropriate segment letter and two-digit segment identifier. For
example, to import data for the Domestic Geographic segment of the Mirage Hotel and Casino,
you would use MIR\G01 as the ticker symbol.

Mnemonics
Valid mnemonics will match mnemonics from the data dictionary of the active database group.

Saving Your File
In order for Research Insight to read your import file, it needs to be saved as a .csv (comma
separated values) file.
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Importing Your Data
After creating a delimited ASCII file, you are ready to import the data into Research Insight.
The data you import will be loaded into the write-to database. (For more information on write-
to databases, see “Managing Your Databases” in Standard and Poor’s Research Insight Beyond
Basics manual.) The file you are importing must be closed before you proceed.

Begin from the Research Insight desktop.

1. From the File menu, select Import. 
You will see the Import dialog box.

2. Select the drive and folder where the file you want to import is located.
3. Enter the name of the file you want to import in the File Name field or select it from 

the list box. 
4. Ensure that the Data radio button is selected. 
5. Click Open to import the file.
6. Click OK when Research Insight displays a message asking you to confirm that the file is

comma separated.

If you saved your spreadsheet as a comma separated file with the .csv extension (comma
separated values), Research Insight displays a message asking you to confirm that the file is
indeed comma separated. If so, click OK. If not, click NO and select the delimiter used
for the file.

A new window will briefly display an import progress bar, the write-to database, the type of 
retrieval key used and the items being imported. Research Insight will tell you when the 
processing is complete.

Hint: An import error file (import.err) is created if an import attempt is unsuccessful. This file
explains what needs to be corrected to import successfully.
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Importing Sets Into Research Insight
This section shows you how to import your own sets from an Excel spreadsheet into Research
Insight. Sets imported into Research Insight must be in a delimited file.

There are two steps involved in importing sets: creating your spreadsheet file and importing the
set from your spreadsheet file into Research Insight.

Creating Your Spreadsheet
To create your spreadsheet file, open a new document in Excel. Create the table header in the
first row. The header must contain a retrieval key, such as a ticker symbol. An example is shown
below.

Next, fill in the company identifiers in cell A2 and down.

We recommend that you save your file as a comma separated values file (*.csv file). After saving
your file, close your spreadsheet application. You are ready to import your set into Research
Insight.

Importing Your Set
Once you have completed your spreadsheet, you are ready to import your set. The set you
import will be added to the write-to database.

Begin from the Research Insight desktop.

1. From the File menu, select Import.
You will see the Import dialog box.

2. Select the drive and folder where the file you want to import is located.
3. Enter the name of the file you want to import in the File Name field or select it from 

the list box. 
4. If you want to import a file delimited by anything other than commas or tabs, click the 

Text Options button, select your column delimiter and click OK.
5. Ensure that the Set radio button is selected. 
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6. Click Open to import the file.
Research Insight displays a message asking you to confirm that the file is a comma 
separated values file. If so, click OK. If not, click NO and select the delimiter used 
for the file.
The Set Type dialog box appears.

7. Select the type of set you want to import. If your spreadsheet contains company ticker 
symbols, you can still choose to import the companies as a Business Segment set, 
geographic segment set or issue set. The retrieval keys in the spreadsheet don’t have to 
match the set type you choose.

8. Click OK.
A window will briefly display an import progress bar, the write-to database, the type of 
retrieval key used and the items being imported.

Hint: An import error file (import.err) is created if an import attempt is unsuccessful. This file
explains what needs to be corrected to import successfully.

The imported set appears on your screen in a spreadsheet format.

9. From the File menu, select Save to save the file as a set.
You will see the Save As dialog box.

10. Enter the set name in the File Name text box.
11. Click Save. Your file is now saved as a set.
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Importing Concepts Into Research Insight
This section shows you how to import concepts into Research Insight. The Import feature
makes it easy to share your concepts with your colleagues. You can create concepts in Research
Insight and export them so they can be imported back into another Research Insight system.
The concepts you import will be added to the write-to database. 

Begin from the Research Insight Desktop.

1. From the File menu, select Import.
You will see the Import dialog box.

2. Select the drive and folder where the file you want to import is located.
3. Enter the name of the file you want to import in the File Name field or select it from 

the list box. 
4. If you want to import a file delimited by anything other than commas or tabs, click the

Text Options button, select your column delimiter and click OK.
5. Ensure that the Concepts radio button is selected. 
6. Select the Concept radio button in the lower right corner and click Open.

The Import Concepts dialog box appears.

7. Select the concepts you want to import in the From list box and click Add. 
8. Click Accept.

Research Insight informs you when processing is complete.
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Standard & Poor’s Research Insight and the COMPUSTAT (Global) database offer a world-class
research solution for analyzing the global marketplace. The Global database provides

• in-depth financial and market data on more than 12,000 active and inactive 
companies in more than 70 countries around the world

• complete histories including income statements, balance sheets and market data

• currency files with cross-translation tables for more than 110 currencies

• monthly pricing data on more than 90 local market indexes

• up to 12 years of historical data

This chapter shows you

• how to change your default database

• content that is unique to the Global database
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Changing Your Default Database 
To demonstrate how you can change your default database from North America to Global, let’s
search for active financial companies in the Global database with issue price to earnings ratios of
less than 15%.

Begin from the Research Insight desktop.

1. From the Databases menu select Default Database. 
The Default Database Group dialog box displays.

2. Select GLOBALVantage from the drop-down list and click OK.

3. Click the        (Research Assistant) button.
You will see the Research Assistant - Step 1 window.

4. Click Change Set, enter $F in the Set field and click OK.
This set contains all active financial companies in the COMPUSTAT (Global) database.

5. Select the Valuation tab and click the Issue Price to Earnings check box.
6. Select < from the drop-down list to the right and enter 15 in the far right field. 

7. Click Next.
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The results of your inquiry will appear in the Research Assistant - Step 2 window. From this
window you can add or remove tickers, save your set, save your screen or continue to the 
next window and use your set in a report or chart.

Content Unique to the Global Database
While the software functionality of Research Insight remains constant whether you are using
North America or Global data, you will see that some data items, data sets, reports and charts
will vary between the two databases. For example, the data items Total Assets and Retained
Earnings will appear in Research Insight whether the North America or Global database is
activated. However, items such as Foreign Exchange Assets and Resale Agreements will only
appear when the Global database is used.

Here’s another example of how content may differ between the two databases. These differences
are the result of varying financial accounting standards around the world. You can view a
current, detailed definition of any data item in the Global database in the on-line help system.
Where applicable, these definitions include both industry- and country-specific information.

Other terms that are specific to the Global database include:

GVKEY: The Global Company Key. A retrieval key similar to a stock ticker symbol that the 
Global database uses to identify a company and serve as the primary key. It is also the 
base of the issue key.

$Sets: A group of companies, segments, issues or currencies in the Global database. Includes:

$GI: The set of corresponding issues for active industrial companies.

$F: The set of financial services companies, including banks and insurance companies 
available in the Global database.
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$FI: The set of corresponding issues for the financial services companies.

$L: The set of local market indexes that are available in the Global database.

$LI: The set of corresponding issues for the local market indexes.

$N: The set of currencies that are available in the Global database.

$D: The set of inactive industrial companies that are available in the Global database.

$DI: The set of corresponding issues for inactive industrial companies.

$X: The set of inactive financial services companies that are available in the Global
database.

$XI: The set of corresponding issues for inactive financial services companies. 

Primary Currency: A currency that you select to facilitate a translation into another currency
when no direct translation rate exists.

Target Currency: The currency in which you want Research Insight to display data for
Screens, Reports and other operations.

ISO Currency Code: A code used to identify currencies in the Global database.

ISO Country Code: A code used to identify countries in the Global database.
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Useful Terms
The following terms are specific to the COMPUSTAT (North America) database. Knowing
them makes navigating through Research Insight much easier.

Base Set: The population to which you apply your screening criteria. Research Insight
contains pre-defined sets (e.g. $C - Active U.S. company data) or you can define your own.

Concept: A mathematical or logical combination of items and/or other concepts, generally
used to save time and increase accuracy when manipulating data in routine, repetitious or
complex expressions. Concepts do not contain values. They are mathematical calculations that
are evaluated each time you use them.

Core Database: A COMPUSTAT database (North America, Global or Price History),
downloaded through http.

Formula: A mathematical or logical combination of one or more items, concepts, functions
and operators that you can build to extract information from the database or perform a
calculation.

Function: A pre-defined calculation tool that you can use to perform numerous tasks, from
something as simple as averaging data for an industry, to more sophisticated analyses using
fractiles. You can use functions in screening, reporting, spreadsheet and concept formulas
individually, or combine them for more complex analysis.

Item: A piece of information collected by Standard & Poor’s and stored in a database. Each
item is identified by a descriptive name and a mnemonic.
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Mnemonic: An abbreviated name used to represent an item within the COMPUSTAT (North
America) database.

Set: A grouping of companies, segments or issues in the COMPUSTAT (North America)
database. Research Insight contains pre-defined sets, such as $C (Active U.S. Companies), but
also allows you to create your own sets. All sets are identified by the dollar sign ($) in front of
their name.
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@ NA. see data codes
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adjustment factor options, 83
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Base Set,
modifying in Classic View, 42
setting the default, 84
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Add All, 18, 22
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Browse, 25, 34
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Change Font, 24
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Chart Assistant, 10, 11
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Close 10, 30
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Company Home Page, 11
Copy, 11
Copy As Bitmap, 24
Copy As Text, 24
Copy to Clipboard, 30
Create New, 10, 11
Customize, 13,18, 22
Cut, 11
Definition, 18,22, 32, 33
Edit Title, 24
Finish, 18, 19, 22, 25
Help, 11, 13, 30
Horizontal Grid, 24
Library, 10, 11
Look Up, 11, 13, 15, 18, 22, 30
Market Insight, 11, 15
Modify Chart Style, 24
Move Down, 18, 22
Move Up, 18, 22
New Item, 18, 22
Next, 14, 15, 16, 18, 22, 23, 29
OK, 26, 27, 29
Open, 11
Open Chart, 10, 11, 70
Open Report, 10, 11, 51
Open Screen, 10, 11
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Open Set, 10, 11, 116
Paste, 11, 30
Print, 11, 14, 15
Remove, 18, 22
Remove Company, 15
Remove Company From ..., 15
Rerun Assistant, 20, 24
Reset, 13, 14, 15
Report Assistant, 10, 11
Research Assistant, 10, 11
Restore Company, 15
Rotate Chart, 24
Run Assistant, 11, 20, 24, 26
Run w/ Time Periods, 14
Run, 14
Save, 11, 13, 14, 15
Save As, 13, 14, 15
Screen Items, 18, 22
Segments, 31
Show / Hide Legend, 24
Show / Hide Series Legend, 24
Sidebar - Desktop, 11
Toolbar - Desktop, 11
Vertical Grid, 24
Welcome window, 11
Z-Clustered, 24
Zoom, 24

Business Descriptions
opening through Library, 112
batch printing, 113
view text for, 116

C

Chart Assistant
opening, 10, 11
Step 1 window, 21

buttons, 21

Step 2 window, 22
buttons, 22

Step 3 window, 23
buttons, 23

using with Excel, 130
Chart window, 24

Toolbar, 24
charts

creating your own/custom, 21–24, 74–75
pre-defined

for multiple companies, 72
modifying, 73
opening, 70, 71

saving, 72
viewing 

the corresponding report, 71
the underlying formulas, 71

Classic View window
accessing, 13, 42
description, 14, 29
working with formulas in, 42

companies
list of, 31

Company Highlights
opening, 10, 11
running report, 50

Concepts 
importing, 149

Country Overviews, 115
creating a free-form report, 58
creating a table report, 54
creating an historical analysis table report 57
current period. see time periods
custom data

importing from a spreadsheet, 145
Custom Indicators window, 13, 79
customize, see also styles 

indicator groups, 79–81
item sets 18, 22, 79–81
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data
importing custom, 146

data availability
and update codes, 105

data codes
options, 84
Not Available (@NA), 105

data items
list of, 32
importing, 146

databases
COMPUSTAT databases, 3

COMPUSTAT (Global), 3
COMPUSTAT (North America), 3
COMPUSTAT(BackData), 3
COMPUSTAT(Classic), 3
Daily Prices, 3
FIRST CALL, 4
I/B/E/S, 4
Stern Stewart’s EVAntageTM, 3

control functions, 99
selecting the default, 5, 152
textual databases, 4

Business Descriptions, 4
Country Overviews, 4
Trends and Projections, 4

Desktop 
sidebar buttons, 11
toolbar buttons, 11

downloads
changing the schedule of, 142
deleting of scheduled, 143
scheduling, 140
suspending of scheduled, 143

E

editing range values, 40
Excel

add-in functions, 133–134
creating a chart with, 130
spreadsheet

creating with Report Assistant, 125–126
creating with Research Assistant, 120
opening Research Insight report in,

123–124
opening Research Insight chart in, 

128–129
opening template, 127

expanding columns, 55

F

File Open window, 25
accessing, 13, 14
buttons, 25

formulas
components, 86

company references, 87
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items, 87
sets, 87
time period references, 88
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operators
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brackets, 89
mathematical, 90
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relational, 90

wildcards, 90
free-form reports, 58
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add-in Excel, 133
currency, 91
database control, 99
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historical analysis, 93
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list of, 33
logical, 94
mathematical, 94
parts of, 91
period reference, 95
reference, 95
screening, 95
set analysis, 97
statistical, 98
text, 98

H

Help
Customer Support, 7
on-screen, 7
web site, 7

historical analysis functions, 93

I

importing. see also Task Scheduler
concepts, 149
data, 145
sets, 147
your own data, 145

import and download results, 144
informational functions, 93
initial set, 38, 71, 60, 52, 12, 75
Initial Set dialog box, 13, 38

accessing 13
internet download, 140

internet settings, 142
Item Definition dialog box

accessing, 18, 22
Item Set Definition dialog box

accessing, 18, 22

L

Library
opening, 10

logical functions, 96
Look Up List

buttons, 30
Companies tab, 31
Functions tab, 33
Items tab, 32
Sets tab, 34

M

mathematical functions, 94
mathematical operators, 90
modifying

adjustment factor, 83
current period cutoffs, 84
data code settings, 84
a pre-defined report, 53
report settings, 82
your default Base Set, 84
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Open Chart
button, 10, 11

Open Report
button, 10, 11

Open Screen
button, 10, 11

Open Set
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Options dialog box, 6
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period reference functions, 95, 110
periodocity. see time periods
print 

chart, 72
Business Descriptions, 113

R

reference functions, 95
relational operators, 90
Report Assistant

opening, 10, 11
Step 1 window, 17

buttons, 17
Step 2 window, 18

buttons, 18
Step 3 window, 19

buttons, 19
Report window, 20
reports

Company Highlights, 50
custom, 17
free-form, 58–60, 65–67
historical, 19, 57
modify settings, 82
opening, 10, 11, 50, 51, 52
pre-defined reports

modifying, 53
running, 51

rerunning. see Rerun Assistant
table, 54–55

examples of, 61–64
expanding columns, 55
modifying setting of, 82
sorting columns in, 56

time periods, 58
Rerun Assistant, 20, 24, 55, 75

Research Assistant, 37 37
Classic View window 14

buttons 14
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screening with, 37
Step 1 window 12

buttons, 13
Step 2 window, 15

buttons, 15
Step 3 window, 16

buttons, 16
Run Assistant, 26

Report Time Periods tab, 28
Screen - Classic View tab, 29
Screen tab, 26
Set tab, 27

S

save
chart, 74
screen, 39, 13, 14
report, 20
set, 15
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screens

Classic View, 42
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examples of, 44–47
saving, 39
viewing results of, 15, 36–37
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sets
changing initial, 38
defining, 15
importing into Research Insight, 147
list of, 34
modifying, 15
saving, 15

sorting columns in a table report, 56
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changing, 78–79
choosing default styles, 5

change your default setting, 6
Corporate Finance, 5
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EVAntage, 6
Money Management, 5
Transfer Pricing, 6

importing, 81
exporting, 81

T

table report 
creating, 56
historical analysis, 59
sorting columns, 58

Task Scheduler
changing import schedule, 139
deleting a task, 143
scheduling a download, 140
scheduling an import, 136
suspending a task, 143
viewing import/download results, 144

text functions, 98
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fiscal year, 102
calendar year, 102

calendar, 19, 23, 28, 108
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definition of, 104
current period cutoff, 84, 105
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in historical analysis reports, 58
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references
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period reference functions, 95
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Trends and Projections

opening through Library, 114
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adding to formulas, 92
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